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Copyright Notice
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any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
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this Epson printer. Epson is not responsible for any use of this information as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for 
damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of 
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to 
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or 
any consumable products other than those designated as Original Epson Products or Epson Approved Products by 
Seiko Epson Corporation.

A Note Concerning Responsible Use of Copyrighted Materials

Ink jet printers, digital cameras, and scanners, like photocopiers and conventional cameras, can be misused by 
improper copying and reprinting of copyrighted material. While some countries’ laws permit limited copying of 
copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. 
Epson encourages each user to be responsible and respectful of the copyright laws when using ink jet printers, 
digital cameras, and scanners.

Trademarks
Epson and Epson Stylus are registered trademarks, and Epson UltraChrome, Epson UltraChrome Hi-Gloss, and 
PRINT Image Matching are trademarks of Seiko Epson Corporation.

BorderFree and RPM are registered trademarks, PhotoEnhance and UltraSmooth are trademarks, and Epson 
PhotoCenter, Epson Store, SoundAdvice, and Epson Connection are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. Epson disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.
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Welcome!

Your Epson Stylus® Photo R1800 gives you beautiful archival prints on a wide variety 
of glossy and matte papers in many sizes.

Your outstanding printouts result from these advanced features:

■ Eight individually-replaceable Epson® ink cartridges let you print at up to 
5760 × 1440 dpi (dots per inch). 

■ Large gamut, pigment-based, Epson UltraChrome Hi-GlossTM inks and 
compatible papers deliver brilliant, long-lasting, water-resistant prints.

■ Unique gloss optimizer cartridge provides a uniform gloss coat on glossy papers so 
your prints look like they came from a photo lab. 

■ Ink droplets as small as 1.5 picoliters give you finer detail and highlights.

■ Photo Black and Matte Black ink cartridges for optimum print density on many 
types of paper without switching cartridges.

■ Large format capabilities let you print panoramics, portraits, and specialty prints 
up to 13 × 44 inches.

■ Versatile paper handling lets you create BorderFree, ® frame-ready prints in popular 
sizes, including 4 × 6, 5 × 7, 8 × 10, 13 × 19, and others. 

■ Direct printing on the surface of ink-jet printable CDs and DVDs for expressive 
disc labels.

■ Roll paper feeder for continuous printing of multiple photos or panoramics.

■ Automatic print head cleaning and alignment utilities analyze your print quality 
and improve it quickly and easily.

■ Fast connections through Hi-Speed USB 2.0 and FireWire® (IEEE 1394) ports.

Note: To achieve the highest USB speed, your computer must also have a 
Hi-Speed USB 2.0 port connected to the printer with a Hi-Speed USB 2.0 cable.



8 Welcome!

PRINT Image Matching and Exif Print

Your Epson Stylus Photo R1800 printer supports these innovative digital image 
formats to give you the best photo prints possible:

■ PRINT Image Matching® (both P.I.M. and P.I.M. II)

■ Exif Print

About PRINT Image Matching

Epson’s revolutionary PRINT Image Matching (P.I.M.) technology lets your digital 
camera and printer work together automatically to produce the best prints possible. 
Digital camera manufacturers that support PRINT Image Matching include Epson, 
Casio,® Fujifilm, JVC,® Konica,® Kyocera,® Leica,® Minolta,® NEC, Nikon,® Olympus,® 
Pentax,® Ricoh,® Sanyo,® Sharp, Sony,® and Toshiba.® Check with your camera’s 
manufacturer or visit www.printimagematching.com to find out if PRINT Image 
Matching technology is included with your camera.

With PRINT Image Matching, the digital camera manufacturer can set specific 
printing options for each camera model. These options include:

■ contrast, sharpness, and brightness

■ gamma level, color space, color saturation, and noise reduction

■ shadow point, highlight point, and color balance

The camera saves this information in each JPEG or TIFF image file. Your printer—
along with the P.I.M. II Plug-in for Adobe® Photoshop® (included with your 
printer)—uses the information to ensure the most accurate image reproduction.

But don’t worry if your camera doesn’t include PRINT Image Matching 
technology—your Epson Stylus Photo R1800 gives great photo printing results, just 
without the adjustments P.I.M.-enabled cameras may add.
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About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your 
digital camera settings in JPEG/TIFF files so your printer and application can use 
them to create accurate print settings. Most digital cameras store Exif Print 
information such as shutter speed, metering, flash, and exposure settings, resolution, 
and lens use in the JPEG/TIFF image file. Your printer—along with the P.I.M. II 
Plug-in for Adobe Photoshop—uses the information to ensure the most accurate 
image reproduction.

About Your Software

Your printer CD-ROM includes all the software you need for printing. See the 
Start Here sheet for installation instructions.

■ Your printer driver runs your printer and lets you control how your documents 
look. You can’t print without it. 

Tip: It’s a good idea to check Epson’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

■ Your photo software includes these great tools:

P.I.M. II Plug-in for Adobe Photoshop lets you retain PRINT Image Matching, 
P.I.M. II, and Exif Print image quality when you import JPEG or TIFF files from 
your P.I.M.-enabled digital camera into Photoshop 6.0, 7.0, and CS, or 
Photoshop Elements 1.0, 2.0, and 3.0. 

EPSON Print CD lets you print directly on ink jet printable CDs and DVDs.

Easy Photo Print works with certain photo printing applications to make 
controlling printing on your Stylus Photo R1800 fast and easy. 

EPSON RAW Print (for Windows) helps you open and print RAW-formatted 
images. 

Epson Premium ICC Color Profiles work with Adobe Photoshop and other 
software applications to control the colors in your prints on various paper types. 
You can download additional profiles at http://support.epson.com. 
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Epson PhotoCenter  is Epson’s free photo-sharing web site where you can store, 
organize, and share your photos; print high-resolution photos straight from the 
web; and create free online postcards. Your printer software installer lets you add a 
link to Epson PhotoCenter on your desktop.

About Your Documentation

To set up your printer and install its software, see the Start Here sheet. 

This book contains system requirements, important safety information, your 
warranty, and instructions on:

■ Loading all types of paper

■ Printing with Windows® or Mac OS® X

■ Printing on ink jet printable CDs and DVDs

■ Maintaining the printer

■ Solving basic problems

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain hints for better printing.

For more details about your printer, network setup instructions and specifications, see 
your on-screen Reference Guide, as described in the next section. 

SM
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Viewing the On-screen Reference Guide

Follow the instructions on the Start Here sheet to install the on-screen Reference 
Guide, if you haven’t already.

Note: You need a browser—such as Microsoft® Internet Explorer 4.0 or later, 
Safari™ 1.0 or later, Mozilla Firefox 1.0 or later, or Netscape® Navigator® 3.0 or 
later—to view the manual. If you are using a different browser, the pages may 
not display correctly. 

1. Double-click the SPR1800 Reference Guide icon on your desktop. 

2. Click a topic on the left to expand the table of contents. 

3. Click on the topic you want to view.

■ If there’s a right arrow , click it to view subtopics, then click on a topic.

■ If there’s a down arrow , click it to close a subtopic list.

Note: If you see an icon for a graphic when viewing your Reference Guide in 
Netscape Navigator, click the Reload button to load the graphic.

Closed list, 
click to 
expand

Click to go 
to topic
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Printer Buttons

The tables below summarize the functions of the printer buttons. 

Printer buttons

Button Uses

) paper Loads or ejects paper.

Resumes printing after a paper-out or multiple-sheet-feed error.

Cancels a print job while printing.

H ink Moves the print head to the ink cartridge replacement position and 
returns it to its home position.

Cleans the print head. Hold down the button for three seconds when 
the red H ink light is off.

z roll paper Prints a cutting guideline and feeds roll paper to the removal position 
after roll paper printing.

Returns roll paper to the printing position after cutting.

Reverses roll paper out of the printer when held down for 3 seconds.

P power Turns the printer on and off. Hold down the button until the Power light 
comes on or goes off.



13

Loading Paper

You can load a variety of paper types in your printer, as described in these sections:

* This matte paper requires the matte sheet support when loading multiple sheets larger than 
letter-size; smaller paper can be loaded without it. See page 16.

Paper/Media Where to load See page

Plain paper

Epson Premium Glossy Photo Paper

Epson Premium Semigloss Photo Paper

Epson Premium Luster Photo Paper

Epson Photo Quality Ink Jet Paper

Epson Photo Quality Self Adhesive Sheets

Epson Premium Bright White Paper

Epson Enhanced Matte Paper*

Epson Matte Paper Heavyweight*

Epson Double-Sided Matte Paper*

Sheet feeder 14, 16

Epson UltraSmoothTM Fine Art Paper

PremierArtTM Matte Scrapbook Photo Paper for 
Epson

Epson Velvet Fine Art Paper

Epson Watercolor Paper - Radiant White

Single sheet guide 18

Roll paper Roll paper holder 22

Ink jet printable CDs and DVDs CD/DVD tray 70



14 Loading Paper

Loading Paper in the Sheet Feeder

1. Open the paper support and pull up the support extensions. 

2. Push in the bottom of the output tray. The tray opens and moves up. 
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3. Pull out the output tray extension.

4. Place your paper in the printer and slide it against the right side of the sheet 
feeder.

Check the following as you load paper:

■ Always load the short edge first, even for printing landscape-oriented 
documents.

■ Load the printable side face up. It’s usually whiter or brighter than the other 
side.

■ Load letterhead or preprinted paper into the printer top edge first.

■ Don’t load paper above the arrow on the left edge guide.

5. Adjust the left edge guide to fit lightly against the paper. 

Output tray
Output tray 
extension
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Loading Special Paper in the Sheet Feeder

You can load these Epson ink jet papers in the sheet feeder as follows:

* This matte paper requires the matte sheet support when loading multiple sheets larger than 
letter-size; smaller paper can be loaded without it. See page 16.

If the special paper has a cut corner, load the paper so the cut corner is positioned as 
shown here. Check the paper package for additional handling instructions.

Note: Always keep unused paper in the original package and store it flat to 
prevent curling. 

Paper type Loading capacity

Epson Enhanced Matte Paper*
Epson Matte Paper Heavyweight*
Epson Double-Sided Matte Paper*
Epson Premium Glossy Photo Paper
Epson Premium Semigloss Photo Paper
Epson Premium Luster Photo Paper

20 sheets (10 sheets for A3 
or Super B sizes)

Epson Photo Quality Ink Jet Paper 100 sheets (50 sheets for A3 
or Super B sizes)

Epson Premium Bright White Paper 80 sheets

Epson Photo Quality Self Adhesive Sheets 1 sheet at a time

Cut corner
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Loading Multiple Sheets of Matte Paper

If you are loading multiple sheets of the following papers in sizes larger than letter 
(8.5 × 11 inches), attach the matte sheet support to the top of the sheet feeder to help 
separate the sheets of paper: 

■ Epson Enhanced Matte Paper

■ Epson Matte Paper Heavyweight

■ Epson Double-Sided Matte Paper

1. Open the paper support and pull up its extensions.

2. Place the hooks on the back of the matte sheet support over the paper support 
extension, then slide it all the way down. 

Note: Remove the matte sheet support when you load other types of paper. 

Matte sheet 
support
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Loading Special Paper in the Single Sheet 
Guide

Load these types of paper in the single sheet guide: 

■ Epson Watercolor Paper - Radiant White

■ Epson Velvet Fine Art Paper

■ Epson UltraSmooth Fine Art Paper

■ PremierArt Matte Scrapbook Photo Paper for Epson

1. Remove the roll paper holder, if it’s installed (see page 22); make sure the 
CD/DVD tray guide is closed (see page 70); and close the paper support and its 
extensions.

2. Slide the roll paper edge guide all the way to the right. 
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3. Line up the notches on the single sheet guide with the slots on the back of the 
printer and insert them as shown. Then insert the tabs on the top of the guide 
into the slot beneath the printer cover. 

4. Turn on the printer (the printer must be on to load paper in the single sheet guide 
correctly). 

5. Insert one sheet of paper against the right edge, then slide the edge guide against 
the sheet. 
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6. Guide the paper into the slot and feed it into the printer until the paper meets 
resistance. 

7. Maintain a constant pressure against the paper until the printer pulls the paper in 
slightly. Let go of the paper to allow the printer to adjust the paper position. 



Loading Paper 21

8. Open the printer cover and look down into the printer to make sure the paper is 
straight; if not, press the z roll paper button for 3 seconds to back the paper out. 
Press the ) paper button to clear the paper out error, then load the paper again. 

9. Before printing, select Manual - Roll as the Source setting (Windows) or 
Manual - Roll as the Paper Source setting (Macintosh) in your printer software 
(see page 28 for Windows or page 33 for Macintosh).

If crooked, reload
paper
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Loading Roll Paper

You can load 4-inch, 8.3-inch, or 13-inch wide roll paper for printing multiple 
photos or panoramics, with or without borders.

Tip: It’s a good idea to check your ink levels before loading and printing on roll 
paper. (See page 81.) If you need to replace a cartridge with roll paper loaded, you 
should remove the paper or marks may appear in your printout.

1. Turn on the printer and remove any paper loaded in the sheet feeder at the top of 
the printer.

2. If the output tray and extension are open, push them in, but leave the flap at the 
end of the tray down.

3. Swing out the roll paper guides until they are straight. 
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4. Place the roll paper on the holders as shown, then remove the tape and protective 
paper from the end of the roll. 

5. Make sure the end of the paper is cut straight across, with 90° corners. If the end 
is cut diagonally, you may have problems feeding the paper.

6. If the paper curls at the end, roll it backwards between a folded sheet of paper to 
uncurl it. 

Avoid touching the printable surface of the roll paper.

90°
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7. Insert the left roll paper holder (marked with an orange triangle) into the far left 
slot (also marked with an orange triangle). Then insert the other holder into the 
corresponding slot on the right.

8. Load the paper part of the way into the roll paper feeder (under the white rollers), 
then slide the right roll paper edge guide to fit lightly against the paper.

9. Push the paper into the feeder as far as it will go; the printer feeds the paper 
automatically.

Caution: Don’t load 
roll paper into the 
sheet feeder or the 
slot behind the paper 
support; make sure it 
is below the white 
rollers.
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10. To verify that the paper is loaded straight, open the printer cover and look into 
the printer. 

If the paper is crooked, press the z roll paper button for three seconds to back 
the paper all the way out. 

Then turn the roll paper holder knobs to roll up the paper. Press the )  paper 
button to clear the paper out error. Repeat steps 7 through 9 to reload the paper.

Follow the instructions on page 41 to print on roll paper.

If crooked, press the 
z roll paper button for 
three seconds
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Printing From Start to Finish

Follow the steps in these sections to print using your printer’s basic features:

■ “Basic Printing in Windows” on page 28

■ “Customizing Your Windows Print Settings” on page 31

■ “Basic Printing With Mac OS X” on page 33

■ “Customizing Your Macintosh Print Settings” on page 38

■ “Selecting the Correct Media Type” on page 40

To print on roll paper or borderless cut sheets, or to print P.I.M. or color-managed 
photos, see “Printing Special Photos” beginning on page 41.

Note: During printing, the left paper guide moves away from the paper slightly. 
Do not re-adjust this while the printer is printing. The printer will re-adjust the 
edge guide once printing is complete. 

Tip: Whenever you print, make sure you:

■ Use the right paper.

For the best-looking photos, most vivid colors, and greatest detail, always 
use genuine Epson papers and Epson UltraChrome Hi-Gloss inks. 

■ Choose the right printer settings for the paper.
Your printer automatically adjusts itself for the type of paper you’ve 
selected, so make sure your printer settings are correct for the paper you 
loaded. 
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Basic Printing in Windows

Follow these steps to print a document or image using the basic printer settings: 

1. From the File menu, click Print. You see a Print window like this one:

2. Make sure EPSON Stylus Photo R1800 is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it first.)

4. Click the Main tab in the printer settings window to see your basic settings.

Click here to open your 
printer software

Check for your 
printer name here

Select your paper 
type (see page 40)

Select your paper 
size Select your 

document or 
image 
orientation

Select the type of 
document you’re 
printing

Select your paper 
source Select your 

print options
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5. Select one of these document types as the Quality Option setting:

■ Draft: For rough drafts with reduced print quality

■ Text: For text-only documents (like letters) with good print quality

■ Text & Image: For documents with text and images with higher print quality

■ Photo: For photos and graphics with good print quality and speed

■ Best Photo: For photos or graphics with high print quality

6. Select the way your paper is loaded as the Source setting:

■ Sheet: For paper loaded in the sheet feeder at the top of the printer

■ Roll: For roll paper loaded in the roll paper feeder on the back of the printer 
(see page 41)

■ Manual - Roll: For paper loaded in the single sheet guide (see page 18)

■ CD/DVD: For CDs or DVDs loaded in the CD/DVD tray (see page 69)

7. Select the type of paper you loaded as the Type setting. See page 40 for details.

Note: For printing photos without borders on certain paper types, click the 
Borderless checkbox. See page 48 for details.

8. Select the size of paper you loaded as the Size setting.

9. Select the direction you want your image or document to print as the Orientation 
setting. Select Portrait for vertical orientation or Landscape for horizontal.

10. Select any other options you want to use in the Print Options box:

■ PhotoEnhanceTM: Improves the contrast, saturation, and color balance of 
low-resolution photos (affects only your printout)

■ Gloss: Applies gloss optimizer on certain paper types. Auto applies it only to 
the image area; Full applies it to the entire page

■ Reverse Order: Prints multiple page documents last-page-first so you don’t 
need to reorder the pages

■ Print Preview: Displays a preview of your printed image or document before 
printing so you can check it for position on the page
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Note: For more information about printer settings, click the ? or Help button. For 
additional print settings, click the Advanced button at the bottom of the screen 
and see page 31 for details.

11. Click OK. You return to the Print window. 

12. Click OK or Print to start printing.

During printing, this window appears. Use it to cancel, pause, or resume printing and 
see how much ink you have left.

Caution: Don’t open Epson Status Monitor, pause printing, or respond to ink 
messages when your printer is printing. This may cause your printer to pause and 
leave an uneven surface on your printout. If ink is low, wait until printing finishes 
before checking ink levels or replacing a cartridge. If you replace an ink cartridge 
in the middle of a print job, the quality of your printout may decline. For best 
results, check ink levels and replace cartridges, if necessary, before printing large 
or high-resolution print jobs.

Selecting the Settings You Use Most Often

Your printer settings apply only to the program you’re currently using. If you want, 
you can change the Windows default printer settings for all your programs.

1. Right-click the  printer icon in the lower right corner of your screen. 

2. Select Printer Settings. You see the window shown on page 28.

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in individual programs, if necessary.

Click to cancel 
printing

Click to pause or 
resume printing
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Customizing Your Windows Print Settings

Follow these steps to print a document or image using advanced printer settings in 
Windows: 

1. On the Main tab, click the Advanced button in the bottom right corner. 

2. Click Continue. The Basic settings change to the Advanced settings: 

Note: If you want to use the Advanced screen each time you access your printer 
settings, select the Show this screen first checkbox.

3. The Advanced settings include the same options as the Basic settings, plus these: 

■ Print quality: Lets you specify a print quality for your selected paper type, 
including Photo RPM® for the highest print quality (5760 × 1440 dpi) on 
certain paper types. (Printing takes longer in this mode.)

■ High Speed: Speeds up printing by allowing printing back and forth across 
the page, instead of in just one direction. (Print quality may decrease.)

■ Edge Smoothing: Prints smoother edges on low-resolution images, such as 
bars in a graph.

Print quality
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■ Color Controls: Lets you adjust the Brightness, Contrast, Saturation, and 
Cyan, Magenta, and Yellow color levels in your printout.

■ ICM: Uses standard color profiles for your printer to match colors in your 
image. If you’re using custom or Epson Premium ICC profiles in a program 
such as Photoshop, select ICM then click Off (No Color Adjustment).

Caution: Incorrectly applying this function or using it in an incomplete color 
management workflow may result in excessively light or dark prints. 

Note: To print with custom color profiles using Photoshop, see “Managing 
Color With Profiles” on page 52.

4. Once you’ve finished selecting advanced settings, you can:

■ Click OK to save your settings, return to the Print dialog box, and print.

■ Click the Basic button to return to the Basic settings.

■ Click the Page Layout tab and continue with step 5 to select layout options.

5. Select the following page layout settings as necessary:

Note: For more information on printer settings, or instructions on saving them as 
a group so you can reuse them later, click the Help or ? button. 

6. Click OK to save your settings, return to the Print dialog box, and print.

Select image or 
document position 
options here

Select image or 
document resizing 
options here; these 
affect only your 
printed image

Add a watermark 
to your printed page 
here

Select multi-page 
document options 
here and here

Adjust the size of 
borderless images 
here (available 
when borderless is 
selected on the 
Main settings 
screen)
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Basic Printing With Mac OS X

Follow the steps below to print a document or image using the basic printer settings. 

For roll paper printing, see page 41. For borderless printing, see page 48. For 
CD/DVD printing, see page 69.

Make sure you added your printer in the Printer Setup Utility or Print Center, as 
described on the Start Here sheet.

1. From the File menu, select Page Setup.

2. Open the Format for menu and select your printer. 

Select Stylus Photo R1800

Select your document or 
image orientation
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3. Choose the paper size for the paper you loaded, then select the source setting from 
the submenu for that size. 

■ For prints on paper loaded in the sheet feeder with borders around the image, 
select just a paper size in the menu and submenu. 

■ For borderless prints on paper loaded in the sheet feeder, select a size with 
Sheet Feeder - Borderless as the source. 

■ For prints with borders around the image on paper loaded in the single sheet 
guide, select a size with Manual - Roll as the source. 

■ For borderless prints on paper loaded in the single sheet guide, select a size 
with Manual - Roll (Borderless) as the source. 

For roll paper printing instructions, see page 41. 

For CD/DVD printing instructions, see page 69. 

Note: For more information on borderless printing, see page 48. 

Caution: When printing non-borderless print jobs using a custom paper size, 
make sure the selected size matches the paper you loaded and is within the 
printable area for your printer. For example, never choose a paper size wider than 
your printer’s sheet feeder or longer than your paper length.

Choose a 
source 
setting

Choose the 
paper size 
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4. Select the direction you want your image or document to print as the Orientation 
setting. Select for vertical orientation, for horizontal facing right, or 

for horizontal facing left.

5. Click OK.

6. Select Print from the File menu. You see a screen like this:

7. Open the Printer menu and select Stylus Photo R1800.

8. Select Print Settings from the pop-up menu. You see your basic print settings: 

Click here and select 
Print Settings 

Select Stylus Photo 
R1800

Select Quality or Speed

Select your paper type 
(see page 40)

Select Automatic mode

Select the ink color
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9. Select the type of paper you loaded as the Media Type setting. See page 40.

Note: If you can’t choose your paper type, check your Page Setup settings to 
make sure you selected the correct paper size and source. (See page 34.)

10. For the ink setting, select Color (for color documents and black and white 
photographs) or Black (for black text documents).

11. Select Automatic as the Mode setting for the best results printing basic 
documents or images. (For instructions on using Advanced mode, see page 38.)

12. Move the slider to the Quality setting to print images or documents using higher 
print quality, or to the Speed setting for faster printing.

Note: For more information about printer settings, click Help. 

13. You can also choose these options in the pop-up menu:

■ Copies & Pages, to select the number of copies or a page range

■ Layout, to select page layout options

■ Output Options, to save your print job as a PDF file

■ Scheduler, to specify a time for a document to print

■ Paper Handling, to reverse page order and set other page options

■ ColorSync, to select Quartz® filters through ColorSync® 

■ Color Management, to select ColorSync, adjust the color controls, change 
the gamma setting, or turn off color adjustments by the printer software (see 
page 39 for color management details) 

■ Expansion (if you selected a Borderless option as the paper size/source 
setting), adjusts the borderless image size to remove borders completely

■ Extension Setting, select Thick media here to correct ink smearing when 
printing on thick paper 

■ Summary, to view a list of all your selections

14. Click Print.
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Caution: Don’t pause printing or respond to ink messages when your printer is 
printing. This may cause your printer to pause and leave an uneven surface on 
your printout. If ink is low, wait until printing finishes before checking ink levels or 
replacing a cartridge. If you replace an ink cartridge in the middle of a print job, the 
quality of your printout may decline. For best results, check ink levels and replace 
cartridges, if necessary, before printing large or high-resolution print jobs.

15. To monitor the progress of your print job, click your printer’s icon or the 
Print Center icon when it appears in the dock. Then double-click Stylus 

Photo R1800. You see this screen:

16. Monitor the progress of your print job or do one of the following:

■ Click the print job, then click Delete to delete the job

■ Click the print job, then click Hold to pause printing

■ Click a print job marked “Hold” and click Resume to resume printing

■ If multiple print jobs are listed, click a print job, then click the Priority arrow 
as necessary to reorder the jobs

17. When you’re finished, close your printer’s status window (OS X 10.3) or Print 
Center (OS X 10.2).
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Customizing Your Macintosh Print Settings 

Follow these steps to print using advanced printer settings on a Macintosh®: 

1. From the File menu, select Print. 

2. Select Print Settings from the pop-up menu.

3. To access advanced settings, click Advanced.

4. In addition to the basic settings, you can select these advanced options: 

■ Print Quality: Lets you specify a print quality for your selected paper type, 
including Photo RPM for the highest print quality (5760 × 1440 dpi) on 
certain paper types. (Printing takes a bit longer in this mode.)

■ High Speed: Speeds up printing by allowing printing back and forth across 
the page, instead of in just one direction.

■ Mirror Image: Inverts the image horizontally.

■ Finest Detail: Places ink droplets in the most precise manner for high quality 
printing. (Printing takes longer in this mode.)

■ Gloss Optimizer: Applies gloss optimizer on certain paper types.
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Note: For more information on advanced settings, or instructions on saving 
them as a group so you can reuse them later, click ?

5. To select Color Management options, select Color Management from the 
pop-up menu. Select Color Management options as follows:

■ Color Controls: Let you adjust the Brightness, Contrast, Saturation, 
Gamma, and cyan, magenta, and yellow levels in your printout. 

■ ColorSync: Uses standard ColorSync profiles for your printer to help match 
colors in your image. [If you’re using custom profiles or the Epson Premium 
ICC profiles in an application such as Adobe Photoshop, select Off (No Color 
Adjustment) instead.]

■ No Color Adjustment: Turns off your printer’s color management features 
so you can use profiles in an application such as Adobe Photoshop instead.

Note: To print with custom or Premium ICC color profiles when you’re using 
Photoshop, see “Managing Color With Profiles” on page 52.

6. Click Print. 
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Selecting the Correct Media Type

Select the correct Type or Media Type setting so your printer knows what kind of 
paper you’re using and adjusts the ink coverage accordingly.

Paper or other media loaded Type or Media Type setting

Plain paper sheets

Epson Premium Bright White Paper

Plain Paper

Epson Photo Quality Ink Jet Paper

Epson Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

Epson Enhanced Matte Paper Enhanced Matte Paper

Epson Matte Paper Heavyweight

PremierArt Matte Scrapbook Photo Paper for 
Epson

Matte Paper - Heavyweight

Epson Double-Sided Matte Paper Double-Sided Matte Paper

Epson Premium Glossy Photo Paper Premium Glossy Photo Paper

Epson Premium Luster Photo Paper Premium Luster Photo Paper

Epson Premium Semigloss Photo Paper Premium Semigloss Photo Paper

Epson Watercolor Paper - Radiant White

Epson UltraSmooth Fine Art Paper

Watercolor Paper - Radiant White

Epson Velvet Fine Art Paper Velvet Fine Art Paper

Ink jet printable CDs or DVDs CD/DVD

Ink jet printable CDs or DVDs with a 
premium surface

CD/DVD Premium Surface
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Printing Special Photos

When you need to print photos using the special Stylus Photo R1800 printing 
features, follow the instructions in these sections:

■ “Printing on Roll Paper” below

■ “Using PRINT Image Matching” on page 46

■ “Printing Borderless Cut Sheets” on page 48

■ “Managing Color With Profiles” on page 52

■ “Easy Printing With Photoshop Elements 3.0” on page 66

Printing on Roll Paper

Before you print on roll paper, load roll paper as described on page 22. 

Then follow the steps in the next sections to select your roll paper settings, control 
printing, and remove and store roll paper.

Caution: Don’t open Epson Status Monitor, pause printing, or respond to any 
on-screen, low ink messages when your printer is printing. This may cause your 
printer to pause and leave an uneven surface on your printout. If your ink is 
running low, wait until printing finishes before checking ink levels or attempting 
to replace a cartridge. If you must replace an ink cartridge in the middle of a print 
job, the quality of your printout may decline. For best results, check your ink 
levels and replace ink cartridges, if necessary, before printing large or 
high-resolution print jobs.
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Selecting Roll Paper Print Settings

Follow the steps in one of these sections to select your roll paper print settings:

■ “Windows” below

■ “Mac OS X” on page 43

Windows

1. Start your print application, open your photo file, and resize it as necessary.

2. Open the File menu, click Print, then 
click Properties or Preferences. 

3. Select the type of roll paper you loaded as 
the Type option:

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper 

■ Premium Glossy Photo Paper

4. If you’ll be printing photos without any 
borders, click the Borderless box.

5. Select the photo size as the Size setting.

If you’re printing a panoramic photo, select User Defined from the Size list and 
enter the size of your photo. Make sure the width of your photo is 4, 8.3, or 
13 inches maximum, depending on the width of the roll paper you loaded. 
Also set the margins to 0 in your printing software.

Note: Don’t select any of these settings when printing on roll paper: PhotoEnhance, 
Reverse Order. For the source, don’t choose Sheet, Manual - Roll, or CD/DVD.

6. Choose Roll as the Source setting. The Roll Paper 
Options dialog box pops up:
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7. Select the roll paper settings based on the type of printing you’re doing, then 
click OK:

8. Click OK.

9. Click OK or Print. Follow the steps on page 45 to remove your printed photos.

Mac OS X

1. Start your print application, open your photo file, and resize it as necessary.

2. Click File > Page Setup.

3. Select Stylus Photo R1800 as the Format for setting:

Type of printing Roll Paper Options

Borderless photos Cut Sheet Mode or 
Banner Mode

Photos with borders or panoramics Cut Sheet Mode

Select Stylus Photo R1800 

Select the size and roll paper 
setting for the photo you’re 
printing 
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4. Select the Roll Paper or Roll Paper - Borderless setting for your photo size as 
the Paper Size setting.

To print without a border between photos, choose the Roll Paper - Borderless 
Banner setting for your photo size. 

Make sure the width of your photo is 4, 8.3, or 13 inches maximum, depending 
on the width of the roll paper you loaded. Also set the margins to 0 in your 
printing software. 

5. Click OK to close the Page Setup dialog box.

6. Click File > Print to open the printer settings dialog box.

7. For the Printer setting, select Stylus Photo R1800.

8. Select Print Settings from the pop-up menu.

9. Select the type of roll paper you loaded as the Media Type option:

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper 

■ Premium Glossy Photo Paper

10. Move the slider to the Quality setting (if available).

Select Stylus Photo R1800 
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11. Choose Roll Paper Option from the pop-up menu. 

12. Select the roll paper settings based on the type of printing you’re doing.

13. When you’re finished, click Print. 

14. Follow the steps below to remove your printed photos. 

Removing Your Printed Photos

1. Press the z roll paper button once to 
feed the paper forward. 

2. Cut the paper on the printed cutting 
line.

3. If you want to print another job on roll 
paper, press the z roll paper button 
once again; the paper returns to the 
correct print position.

4. Follow the steps in the next section if 
you’re finished printing on roll paper.

Type of printing Roll Paper Options

Borderless photos Cut Sheet Mode or 
Banner Mode

Photos with borders or panoramics Cut Sheet Mode
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Removing and Storing Roll Paper

1. Press the z roll paper button for three seconds. The paper feeds backwards out of 
the printer. (If it doesn’t feed all the way out, repeat this step.)

2. Turn the knobs to roll the rest of the paper onto the holder. Then press the 
) paper button to turn off the ) paper light.

3. Pull the roll paper holder off of the printer and remove the roll paper from it.

Return the unused roll to its original package. Store your printouts in resealable 
plastic bags, photo albums, or glass-covered picture frames. Keep both printed and 
unused roll paper away from high temperatures, humidity, and direct sunlight.

Using PRINT Image Matching

With PRINT Image Matching, special print instructions are saved in your digital 
photo files. For example, macro mode pictures might include print commands for 
sharpness and clarity, while portrait mode pictures might emphasize soft focusing and 
subtle flesh tones. If your digital camera supports PRINT Image Matching (P.I.M. or 
P.I.M II), you can use this technology when you print with the P.I.M. II Plug-in for 
Adobe Photoshop. 

Knob
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Using the P.I.M. II Plug-in for Adobe Photoshop

The P.I.M. II Plug-in for Adobe Photoshop allows you to retain the P.I.M. or Exif 
Print image quality when you import JPEG or TIFF files from your P.I.M.- or Exif 
Print-enabled digital camera. The P.I.M. II Plug-in works with Photoshop 6.0, 7.0, 
and CS, and Photoshop Elements 1.0, 2.0, and 3.0. You’ll also need to install the 
Premium ICC profiles for your printer that are included on the printer CD-ROM 
and that are available for download from http://support.epson.com.

Photoshop doesn’t retain the PRINT Image Matching or Exif Print information 
separately in the header file when you import your P.I.M. or Exif Print image. 
Instead, it converts that information in the file and embeds a color space called 
EPSON RGB 2001. This profile supports all the P.I.M. color advantages and 
enhancements.

You can crop, rotate, resize, work with layers, play with filters, and even make 
selective color adjustments to the P.I.M. image while retaining P.I.M. quality. 
However, you won’t benefit from global color adjustments (such as Auto Levels, Auto 
Contrast, Auto Color, etc.). Also, if you try to use your new Photoshop file in another 
P.I.M.-enabled software program, it won’t be recognized as a P.I.M. image. You need 
to keep your original file to take advantage of P.I.M. information in other programs.

For instructions on using the P.I.M. II Plug-in, double-click the P.I.M. II Plug-In.pdf 
icon on your desktop.
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Printing Borderless Cut Sheets

You can print your photos with no margins, extending the image all the way to the 
edges of the page. Although borderless printing is a bit slower, you get beautiful 
portraits and enlargements, without trimming, on these papers: 

■ Epson Premium Glossy Photo Paper 

■ Epson Matte Paper Heavyweight*

■ Epson Enhanced Matte Paper*

■ Epson Double-Sided Matte Paper *

■ Epson Premium Luster Photo Paper

■ Epson Premium Semigloss Photo Paper

■ Epson Watercolor Paper - Radiant White

■ Epson Velvet Fine Art Paper**

■ Epson UltraSmooth Fine Art Paper**

■ PremierArt Matte Scrapbook Photo Paper for Epson**

*If you are loading multiple sheets of matte paper that are larger than letter-size, use 
the matte paper support. See page 17.

**These papers must be loaded in the single sheet guide. See page 18.

Caution: Don’t open Epson Status Monitor, pause printing, or respond to any ink 
messages when your printer is printing. This may cause your printer to pause and 
leave an uneven surface on your printout. If your ink is running low, wait until 
printing finishes before checking ink levels or attempting to replace a cartridge. If 
you must replace an ink cartridge in the middle of a print job, the quality of your 
printout may decline. For best results, check your ink levels and replace ink 
cartridges, if necessary, before printing large or high-resolution print jobs.
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Follow the steps for your operating system in these sections to print BorderFree 
photos on cut sheet paper.

■ “Windows” below

■ “Mac OS X” on page 50

Windows

1. Start your printing application and open 
your photo file.

2. Open the File menu and click Print, 
then click Properties or Preferences. 

3. Select Photo or Best Photo as the 
Quality Option.

4. Choose Sheet as the Source setting.

5. Select the type of paper you loaded as the 
Type setting. See page 40 for details.

6. Click the Borderless checkbox.

7. Select your paper size as the Size setting.

8. Select Portrait or Landscape as the orientation setting.

9. Click the Page Layout tab, then adjust the Expansion setting. Choose Min for 
the least amount of image expansion (with a chance that there may be small 
borders around the edges) or Max for the greatest amount of expansion (some of 
the image will be cut off around the edges, but it will extend to the edge of the 
paper). 

10. Click OK.

11. Click OK or Print.



50 Printing Special Photos

Mac OS X

1. Start your printing application and open your photo file.

2. Click File > Page Setup.

3. Select Stylus Photo R1800 as the Format for setting.

4. Select the size of the paper you loaded with a Sheet Feeder - Borderless source 
as the Paper Size setting.

5. Select one of the portrait or landscape orientation icons as the Orientation setting.

6. Click OK.

Select Stylus Photo R1800 as the 
Format for setting

Select the size of the paper you 
loaded here
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7. Click File > Print.

8. For the Printer setting, select Stylus Photo R1800.

9. Select Print Settings from the pop-up menu.

10. Select the type of paper you loaded as the Media Type setting. See page 40.

Note: If you can’t choose your paper type, check your Page Setup settings to 
make sure you selected the correct paper size and source. (See page 34.)

11. Move the slider to the Quality setting.

12. Choose Expansion from the pop-up menu, then adjust the Expansion setting. 
Choose Min for the least amount of image expansion (with a chance that there 
may be small borders around the edges) or Max for the greatest amount of 
expansion (some of the image will be cut off around the edges, but it will extend 
to the edge of the paper). 

13. Click Print.
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Managing Color With Profiles

Follow the steps in this section to use color profiles for printing with Adobe 
Photoshop (the instructions cover Photoshop CS). 

Carefully follow the instructions in these sections for the best results:

■ “Printing With a Color Profile” below

■ “Solving Color Management Problems” on page 61

■ “Printing a Custom Profile Test Target” on page 61 

■ “Creating a Custom Profile” on page 65

Printing With a Color Profile

To print an image using a profile, follow the steps in the appropriate section for your 
operating system below.

Mac OS X

Opening Your Image

1. Open Adobe Photoshop.

2. Select Color Settings from the 
Photoshop menu.

3. Select U.S. Prepress Defaults from the 
Settings pull-down menu. This sets 
Adobe RGB (1998) as the RGB working 
space and activates warning messages for 
profile mismatches and missing profiles. 
Click OK.
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4. Open the photo you want to print.

5. If you see the message shown below, select Use the embedded profile (instead 
of the working space) option and click OK. It is generally best to use the 
embedded profile.

6. If you see the message shown below, select Assign working RGB: Adobe RGB 
(1998) and click OK.

7. When your image appears, evaluate the color balance and contrast as displayed on 
your monitor. If they need improvement, select Image > Mode > Assign 
Profile. Select one of the following as the Profile setting:

■ A different RGB working space, such as ColorMatch RGB or sRGB 
IEC61966-2.1

■ A scanner profile for your scanner

■ A camera profile for your digital camera

Also click the Preview box so you can see the effects of your profile choice on the 
screen.

Note: Assigning a profile to the image doesn’t alter the image data, only the 
interpretation of the data by your software and how it appears on your monitor 
and in a printout. This is the best way to improve the color balance and contrast in 
your image.
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Selecting Your Print Settings

1. Select File > Print with 
Preview. You see this 
window:

2. Click the Page Setup 
button to change the page 
size and orientation 
settings as necessary, then 
click OK.

3. Click Show More Options. Select Color Management from the pop-up 
menu. Additional options appear:

4. Under Print Space: Profile, select a profile for your printer and the paper you’ll 
use for the print.

Note: The Epson Premium ICC profiles can be identified with the suffix “.icc,” for 
example, “SPR1800 PrmGlsy BstPhoto.icc.” 

5. As the Print Space: Intent setting, select Relative Colorimetric.

Note: If your image contains very saturated colors, select Perceptual instead. 
This reduces the color saturation so that the colors fit within the printer’s color 
gamut.

6. Select the Use Black Point Compensation checkbox.
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Printing Your Color-Managed Photo

1. Click the Print button.

2. Select Stylus Photo R1800 from the Printer menu.

3. Select Print Settings from the pop-up menu.

4. Select the Media Type setting for the paper you’ll use for the printer.

5. Click the Advanced button.

6. If you are using an Epson Premium ICC profile, set the Print Quality setting to 
match your profile. 

7. If you are printing on Premium Glossy Photo Paper, Premium Semigloss Photo 
Paper, or Premium Luster Photo Paper, make sure Gloss Optimizer is set to On. 

8. Turn off the High Speed option.
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9. Select Color Management from 
the pop-up menu.

10. Select Off (No Color 
Adjustment).

Note: Make sure that you select Off 
(No Color Adjustment). If you don’t, 
the printer driver will apply additional 
correction to the image data, 
producing inaccurate results.

11. Click Print to print your photo.

Windows

Opening Your Image

1. Open Adobe Photoshop.

2. Select Edit > Color Settings.

3. Select U.S. Prepress Defaults from the 
Settings pull-down menu. This sets Adobe 
RGB (1998) as the RGB working space 
and activates warning messages for profile 
mismatches and missing profiles. Then 
click OK.

4. Open the photo you want to print.

5. If you see the message shown below, select Use the embedded profile (instead 
of the working space) option and click OK. It is generally best to use the 
embedded profile.

IMPORTANT!

Select Off (No Color Adjustment)
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6. If you see the message shown below, select Assign working RGB: Adobe RGB 
(1998) and click OK.

7. When your image appears, evaluate the color balance and contrast as displayed on 
your monitor. If they need improvement, select Image > Mode > Assign 
Profile. Select one of the following as the Profile setting:

■ A different RGB working space, such as ColorMatch RGB or sRGB 
IEC61966-2.1

■ A scanner profile for your scanner

■ A camera profile for your digital camera

Also click the Preview box so you can see the effects of your profile choice on the 
screen.

Note: Assigning a profile to the image doesn’t alter the image data, only the 
interpretation of the data by your software and how it appears on your monitor 
and in a printout. This is the best way to improve the color balance and contrast in 
your image.

Selecting Your Print Settings

1. Select File > Page Setup.

2. Click the Printer button.

3. Make sure the correct printer is selected, then click OK.
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4. Select the size of your paper as the Size setting.

5. Select the orientation of your image.

6. Click OK.

7. Select File > Print with Preview.

8. Click Show More Options. If you see Output, select Color Management from 
the pull-down menu. Additional options appear:
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9. Under Print Space: Profile, select a profile for your printer and the paper you’ll 
use for the print.

Note: The Epson Premium ICC profiles can be identified with the suffix “.icc,” for 
example, “SPR1800 PrmGlsy BstPhoto.icc.” 

10. As the Print Space: Intent setting, select Relative Colorimetric.

Note: If your image contains very saturated colors, select Perceptual instead. 
This reduces the color saturation so that the colors fit within the printer’s color 
gamut.

11. Select the Use Black Point Compensation checkbox.

Printing Your Color-Managed Photo

1. Click the Print button.

2. Make sure your printer is selected, and click the Properties button. 

3. Select the Best Photo or PhotoRPM setting as the Quality Option. (If you are 
using an Epson Premium ICC profile, set the Print Quality setting to match your 
profile.)

4. Select the Type setting for the paper you’ll use for the print.

5. Click the Advanced button.

6. Turn off the High Speed and Edge Smoothing options, if they are available.
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7. Click the ICM button under Color Management.

8. Click the Off (No Color Adjustment) button.

Note: Make sure that you select Off (No Color Adjustment). If you don’t, the 
printer driver will apply additional correction to the image data, producing 
inaccurate results.

9. If you are printing on Premium Glossy Photo Paper, Premium Semigloss Photo 
Paper, or Premium Luster Photo Paper, make sure the Gloss checkbox is selected.

10. Click OK.

11. Click OK to print.

IMPORTANT!

Select ICM, then click 
Off (No Color Adjustment)
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Solving Color Management Problems

If you selected the wrong combination of source profile, printer profile, and color 
management settings, you’ll get unexpected results. Try these solutions:

■ If your printed image is darker than expected and/or has a strong yellow-brown 
cast, you probably turned off color management in both Photoshop and the 
Epson printer driver. 

Return to the Print with Preview instructions for Adobe Photoshop on page 54 
(for Mac OS X) or page 57 (for Windows). Make sure the Source Space - 
Document option is not set to Untagged RGB. Also make sure you selected the 
correct profile for your printer in the Print Space - Profile menu.

■ If your printed image is lighter than expected and/or has a strong light blue cast, 
you probably turned on color management in both Photoshop and the Epson 
printer driver. 

Return to the instructions on page 56 (for Mac OS X) or page 60 (for Windows). 
Make sure to select Off (No Color Adjustment) in the printer driver Advanced 
screen or Color Management menu to turn off color management in your Epson 
printer driver.

Printing a Custom Profile Test Target

Follow the steps in this section to create and print individual custom profile test 
targets for each paper type you plan to print on.

When you’re ready to print the test target, follow the steps for your operating system 
below.

Mac OS X

1. Open Adobe Photoshop and open the profile target file provided by your 
profile-building software manufacturer.

2. If you see a missing profile screen, select Leave as is (don’t color manage).

3. Select File > Print with Preview.

4. In the Print window, click the Show More Options checkbox, then choose 
Color Management in the pop-up menu.
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5. Select Same as Source as the Print Space: Profile setting.

6. Click the Page Setup button.

7. Select Stylus Photo R1800 from the Format for menu.

8. Select the appropriate Paper Size and Orientation settings, then click OK.

9. Click the Print button.

10. Select your printer from the Printer menu, then select Print Settings from the 
pop-up menu.
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11. Select the Media Type setting for the profile you’re printing.

12. Click the Advanced button.

13. Select your desired level as the Print Quality setting. 

14. Turn off the High Speed option.

15. Select Color Management from the pop-up menu. 

16. Click Off (No Color Adjustment).

17. Click Print to print your test target.

18. Repeat these steps to print a test target for each paper type and Print Quality 
setting you plan to print with.

IMPORTANT!

Select Off (No Color 
Adjustment)
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Windows

1. Open Adobe Photoshop and open the profile target file.

2. If you see a missing profile screen, select Leave as is (don’t color manage).

3. Select File > Print with Preview.

4. In the Print window, click the 
Show More Options checkbox, 
then choose Color Management 
in the drop-down menu.

5. Select Same as Source as the 
Print Space: Profile setting.

6. Click the Print button.

7. Click the Properties button.

8. Select your desired level as the 
Quality Option.

9. Select the Type setting for the paper you’ll use for the print.

10. Click the Advanced button.

11. Turn off the High Speed and Edge Smoothing options, if they are available.
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12. Click the ICM button under Color Management.

13. Click the Off (No Color Adjustment) button.

14. Click OK.

15. Click OK to print.

16. Repeat these steps to print a test target for each paper type and Quality Option 
setting you plan to print with.

Creating a Custom Profile

If you’re creating a custom profile for your printer, follow the instructions provided 
with your profile-building software (such as MonacoEZcolor by X-Rite or 
GretagMacbeth ProfileMaker) to create your custom profile using the test target you 
printed. Once you create the profile, be sure to place it in the correct folder on your 
computer, as recommended by Microsoft or Apple.®

IMPORTANT!

Select ICM, then click 
Off (No Color Adjustment)
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Easy Printing With Photoshop Elements 3.0 

If you are using Adobe Photoshop Elements 3.0 with Windows, you can take 
advantage of the Epson EasyPrint interface when you’re ready to print. It lets you 
select your basic settings directly from the Print window, so you don’t need to open 
the Properties or Preferences window to access the printer driver. 

This one-stop printing feature also prevents conflicts between software and driver 
settings by making them both match. 

Complete instructions for using Adobe Photoshop Elements 3.0 are provided in the 
Getting Started Guide installed with Photoshop Elements. Follow these steps to open 
Elements and access the EasyPrint interface:

1. To start the program, double-click the Adobe Photoshop Elements 3.0 icon 
on your desktop.

2. Select View and Organize Photos. You see the Photo Browser workspace and 
Organizer at the top of the screen.

3. Open the folder containing the photo(s) you want to print. Select Get Photos 
from the File menu and choose an option such as From Files and Folders. Then 
select the photo(s). 

If you need to edit a photo, go to step 4. If you are ready to print, go to step 5. 

4. To edit a photo, click the Edit button and choose either Go To Quick Fix or Go 
To Standard Edit. When you finish editing and are ready to print, click Photo 
Browser to return to Organizer mode. Do not print from Editor mode.

Note: If you print in Editor mode, you do not see the Epson EasyPrint interface 
and you must click Print > Print > Properties to access the printer driver settings.
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5. Select Print from the File menu. You see the Epson EasyPrint interface:

6. Change your print settings, as necessary.

7. Click Print to start printing.

Select EPSON 
Stylus Photo R1800

Select your paper type

Choose your paper 
size and orientation

Click here for 
borderless printing

Select other print 
settings

Click here for more print options
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Printing on CDs and DVDs

Your printer includes a special tray that lets you print customized text, graphics, and 
photos directly on any ink jet printable CD or DVD. The Epson Print CD software 
makes it easy to import your own photos, add text, and modify your designs with a 
variety of special effects. You can print on both regular 12-cm discs and 8-cm mini 
CDs.

Caution: Use only ink jet-printable CDs or DVDs for printing. Do not use 
thermal-printable or regular CDs or DVDs.

You can order CDs and DVDs with an ink jet printable surface from your local 
retailer or a website such as www.pcmall.com, www.cdw.com, www.warehouse.com, 
www.zones.com, www.macconnection.com, and www.pcconnection.com.

Follow the steps in these sections to print on your CDs or DVDs:

■ “Cleaning the Roller” on page 70

■ “Inserting a CD or DVD” on page 70

■ “Printing Your Design” on page 73

■ “Adjusting the Print Position” on page 74

■ “Adjusting the Print Density” on page 75



70 Printing on CDs and DVDs

Cleaning the Roller

Before you print on CDs or DVDs, you may need to clean the roller inside the 
printer. You can do this by feeding and ejecting several sheets of plain paper. 

1. Open the output tray and extension. 

2. Open the paper support and pull up the support extensions.

3. Turn on the printer and load several sheets of letter-size paper.

4. Press the ) paper button to feed the paper. 

5. Press the ) paper button again to eject the paper. 

6. Repeat steps 4 and 5 several times to completely clean the 
roller. 

Inserting a CD or DVD

Make sure the data, music, or video is burned on your ink jet printable CDs or DVDs 
before you print. Otherwise, dirt or scratches on the surface may cause errors when 
you burn the data. If you plan to print large numbers of CDs or DVDs, it’s a good 
idea to print a small sample, then wait a day and check the quality to make sure it is 
satisfactory. 

If you want to check the print position or color before printing on your actual CD or 
DVD, see “Adjusting the Print Position” on page 74 or “Adjusting the Print Density” 
on page 75.

1. Turn on the printer.

Note: Before you insert a CD or DVD, make sure the printer is turned on. 
Otherwise, the disc may not be positioned correctly.

2. Remove any paper from the sheet feeder, then push in the paper support 
extensions and close the paper support.

3. If the output tray and extension are open, push them in, but leave the flap at the 
end of the tray down.
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4. Lift up the printer cover and press in the top of the CD/DVD tray guide as 
shown. 

5. Lower the CD/DVD tray guide. 
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6. Place the CD or DVD on the CD tray with the white or printable side face-up.

To print on a small CD (8 cm), place the small CD ring on the tray first, then 
place the CD inside the ring. 

Caution: Make sure you always use the small CD ring when printing 8-cm CDs 
and that the CD and ring lay flat on the tray; otherwise the printer may be 
damaged.

7. Slide the tray into the CD/DVD tray guide. Push in the tray until the arrows on 
the tray and the tray guide are aligned, as shown below. 

8. Press the ) paper button to load the CD or DVD into printing position. It is 
loaded when the P power button stops flashing.

9. Use Epson Print CD to design your CD or DVD (for instructions, see the 
on-screen Help), then print your CD or DVD, following the instructions below. 

Always use this 
piece with 8-cm CDs

Push in only until the 
arrows are next to 
each other
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Printing Your Design

After you have created your design and loaded a CD or DVD, you’re ready to print.

Note: For information on designing CDs and DVDs, see the EPSON Print CD 
on-screen Help.

1. Start Epson Print CD, if necessary, and open your design file. 

2. Open the File menu and select Print.

3. Make sure EPSON Stylus Photo R1800 is selected, then click Print.

The printer prints your CD or DVD and ejects it on the tray. 

Note: After you print, handle the CD or DVD carefully. To allow the ink to dry fully, 
wait at least 24 hours before playing the disc or inserting it in a drive. Keep 
printed discs away from moisture and direct sunlight. 

If you need to adjust the print position or color, see the instructions for “Adjusting 
the Print Position” on page 74 and “Adjusting the Print Density” on page 75.

Macintosh

Windows
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Adjusting the Print Position

If your printed images and text are not positioned the way you want, you may need to 
adjust the printing position. Use the blank cardboard position check disk included 
with your printer or an extra CD. You can also use these steps to check the position 
before you print on a CD or DVD.

1. Place the position check disk (or an extra ink jet printable CD) on the CD tray 
and insert it into the printer, as described on page 70.

2. Start Epson Print CD.

3. Select Print from the File menu.

4. Make sure EPSON Stylus Photo R1800 is selected, then click Print Position 
Confirmation Pattern (Windows) or Print Position Check Pattern 
(Macintosh).

5. Click Print. The confirmation pattern is printed on the position check disk or 
CD and the printer ejects the tray. 

Macintosh

Windows
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6. Remove the position check disk or CD and measure the distance from the edge of 
the hole to the small cross marks (distances labeled A and B as shown). You’ll need 
a metric ruler with millimeters for these measurements.

7. Open the File menu and select Adjust Print Position. You see a screen like this:

8. Make sure Enter Values (Windows) or Value Entry (Macintosh) is checked. 
Input the A distance in the Height (Top) or Top Space box. Enter the B 
distance in the Width (Right) or Right Space box.

9. Click OK to save the measurements.

Adjusting the Print Density

If ink smears on your printed CDs or DVDs, you may need to adjust the color 
saturation or ink density. Discs from different manufacturers may absorb ink 
differently, so you may need to adjust the density for each type of disc. Follow these 
instructions to print a color saturation check pattern and make adjustments as 
necessary.

1. Start EPSON Print CD.

2. Insert a test CD or DVD for printing, as described on page 70.

3. Select Print from the File menu.

Enter measurements here

MacintoshWindows

Enter measurements here
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4. Make sure EPSON Stylus Photo R1800 is selected, then click Print Density 
Confirmation Pattern (Windows) or Print Density Check Pattern 
(Macintosh).

5. Click Print. The printer prints the pattern and ejects the tray. 

6. After the pattern is printed, examine the print and make the Print Color 
Correction (Windows) or Color Correction (Macintosh) setting lighter or 
darker as necessary.

You can print three density patterns on one disc. Each pattern is printed in a 
different location.

7. After the first pattern is printed, adjust the setting, then repeat steps 2 through 6, 
selecting Second or Second Time to print the second pattern. 

8. If you want to try a third Color Correction setting, you can repeat steps 2 through 
6 again and select Third or Third Time.

9. Remove the CD or DVD and let it dry for at least 24 hours. Then check the 
saturation levels again.

You can also use the Brightness and Contrast settings in Epson Print CD to adjust 
color saturation. See the Epson Print CD on-screen Help for instructions.

Macintosh

Windows
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Maintaining Your Printer

Follow the instructions in this chapter to keep your printer working at its best and to 
prepare it for moving, if necessary: 

■ “Cleaning the Print Head” below

■ “Replacing an Ink Cartridge” on page 80

■ “Aligning the Print Head” on page 84

■ “Cleaning the Printer” on page 86

■ “Transporting the Printer” on page 87

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing, you may need 
to clean the print head. This unclogs the nozzles so they can deliver ink properly. 
Print head cleaning uses ink, so clean it only if quality declines. 

Caution: When you don’t turn on your printer for a long time, print quality can 
decline, so turn it on at least once a month to maintain good print quality.

This section explains how to clean the print head using the Auto Nozzle Check and 
Cleaning utility and the Head Cleaning utility. Use the Auto Nozzle Check and 
Cleaning utility first, to let the printer check and clean the nozzles. If you still notice 
problems with quality, you can manually clean the print head. 

Note: You can also clean the print head by holding down the H ink button on the 
printer for three seconds (when the red H ink light is off).
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Automatically Checking and Cleaning the Print 
Head

The Auto Nozzle Check and Cleaning utility prints a nozzle check pattern that the 
printer then reads to see if you have any clogged nozzles. If cleaning is needed, the 
printer automatically cleans the print head.

1. Make sure the printer is turned on but not printing, and the red H ink light is off. 
(If the H ink light is flashing or on, you need to replace a cartridge; see page 80.)

2. Load several sheets of plain, letter-size paper in the printer’s sheet feeder.

3. Do one of the following:

Windows: Right-click the  icon on your taskbar (in the lower right corner of 
your screen). Select Auto Head Cleaning.

Mac OS X: Open the Applications folder and select EPSON Printer Utility. 
Select SP R1800, click OK, and select Auto Nozzle Check and Cleaning.

4. Follow the instructions on the screen. The printer prints and examines the nozzle 
check pattern shown below. If cleaning is necessary, it then cleans the print head 
and prints and checks another nozzle check pattern.

5. The utility prints and checks up to five times. If some print head nozzles are still 
clogged, it displays an on-screen message telling you to manually clean the print 
head. Follow the instructions on page 79 to clean the print head, if necessary.

If you still have print quality problems, check the solutions beginning on page 96. 
You can also turn the printer off and wait overnight—this allows any dried ink to 
soften—and then try cleaning the print head again.
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Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the red H ink light is off. 
(If the H ink light is flashing or on, you need to replace a cartridge; see page 80.)

2. Do one of the following:

Windows: Right-click the  icon on your taskbar (in the lower right corner of 
your screen). Select Head Cleaning.

Mac OS X: Open the Applications folder and select EPSON Printer Utility. 
Select SP R1800, click OK, and select Head Cleaning.

3. Follow the instructions on the screen to clean the print head. 

Cleaning takes about two minutes, 
during which the printer makes noise 
and the green P power light flashes.

4. When the green P power light stops flashing, make sure paper is loaded in the 
printer. Click Print nozzle check pattern, then click Print (Windows) or click 
Confirmation, then click Next (Macintosh). The nozzle check pattern prints.

5. If the nozzle check pattern has no gaps or lines (as shown below), click Finish.

Caution: Never turn off the printer 
while the green P power light is 
flashing, unless the printer hasn’t 
moved or made noise for more 
than 5 minutes.
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If the pattern has white lines or gaps (as shown below), click Clean to clean the 
print head again.

If you don’t see any improvement after cleaning the print head three or four times, 
check the solutions beginning on page 96. You can also turn the printer off and wait 
overnight—this allows any dried ink to soften—and then clean the print head again.

Replacing an Ink Cartridge

When the red H ink light flashes, an ink cartridge is low on ink. 

When the red H ink light stays on, you need to replace a cartridge.

You can open the printer cover to check the ink light indicating a cartridge that is low 
on ink or needs to be replaced. 

When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if the red H ink light is off.

Caution: Don’t open Epson Status Monitor or respond to any ink messages 
when your printer is printing. This may cause your printer to pause and leave an 
uneven surface on your printout. If your ink is running low, wait until printing 
finishes before checking ink levels or attempting to replace a cartridge. If you 
must replace an ink cartridge in the middle of a print job, the quality of your 
printout may decline. For best results, check your ink levels and replace ink 
cartridges, if necessary, before printing.
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Checking the Ink Supply

To check your ink supply, do one of 
the following:

■ Windows: Double-click the  icon on the 
Windows taskbar. You see a window like this: 

■ Mac OS X: Choose Applications > EPSON 
Printer Utility > SP R1800 > EPSON 
StatusMonitor.

You see a window like this:

Click a cartridge image to display information about 
the cartridge.

Purchasing Ink Cartridges

Use these Epson ink cartridges within six months of installing them and before the 
expiration date on the package:

Caution: To ensure good results, use genuine Epson ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered by 
Epson’s warranty.

You can purchase genuine Epson ink cartridges, paper, and accessories from an Epson 
authorized reseller. For product information and to find the nearest authorized 
reseller, please call 800-GO-EPSON (800-463-7766) or browse our catalog of 
products at www.epson.com, select the product you are interested in, and click 

Ink cartridge Part number

Yellow T054420

Magenta T054320

Cyan T054220

Matte Black T054820

Photo Black T054120

Red T054720

Blue T054920

Gloss Optimizer T054020
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“Where to Buy.” To purchase online, please visit the Epson StoreSM at 
www.epsonstore.com (U.S. sales only). In Canada, please call 800-463-7766 
for a reseller referral. 

Ink Cartridge Precautions

Warning: Keep ink cartridges out of the reach of children; don’t drink the ink. 

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
in your eyes, flush them thoroughly with water.

Caution: To avoid damaging the printer, never move the print head by hand.

You cannot print if an ink cartridge is empty. Leave the empty cartridge installed 
in the printer until you have obtained a replacement. Otherwise the ink remaining 
in the print head nozzles may dry out.

Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a 
cartridge, you must complete all the steps in one session.

You can replace a cartridge whether the red H ink light is off, flashing, or on.

1. Make sure the printer is turned on (the green P power light should be on, but not 
flashing). Then open the printer cover.

2. Press the H ink button. 

The print head moves and the green P power light flashes.

If a red ink light is flashing or on (indicating a low or empty cartridge), the 
cartridge(s) indicated beneath the light(s) needs to be replaced. 

3. Lift up the cartridge cover.



Maintaining Your Printer 83

4. Press in the tab on the back of the cartridge, lift it out of the printer, and dispose 
of it carefully.

5. Shake the new cartridge four or five times before 
opening its package. (Don’t shake it after it’s 
unpacked.)

6. Remove the new cartridge from its package.
 

7. Slide the new cartridge into its slot. The side with the green circuit board goes in 
the front of the slot.

8. Press the cartridge down until it clicks into place.

9. If you need to replace any other ink cartridges, repeat steps 4 through 8.

10. Close the cartridge cover, press it down on the top until it clicks, then close the 
printer cover.

Caution: Don’t touch the green circuit board on 
the front of the cartridge; you may inhibit normal 
operation and printing. 
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11. Press the H ink button. The printer begins charging the ink delivery system.

The green P power light and red H ink lights flash and the printer makes noise. 
Charging takes about 90 seconds. When it’s finished, the green P power light 
stops flashing and stays on. The red H ink light and the light(s) above the 
cartridge(s) go out.

Caution: Never turn off the printer while the green P power light is flashing, 
unless the printer hasn’t moved or made noise for more than 5 minutes.

Aligning the Print Head

If your printouts contain misaligned vertical lines, or you see light or dark horizontal 
banding, you may need to align the print head. You can have the printer 
automatically check and align the print head or you can check and adjust the 
alignment yourself.

Automatically Aligning the Print Head

1. Turn on the printer.

2. Load plain, letter-size paper.

3. Do one of the following:

Windows: Right-click the  icon on your taskbar (in the lower right corner of 
your screen). Select Print Head Alignment.

Mac OS X: Open the Applications folder and select EPSON Printer Utility. 
Select SP R1800, click OK, and select Print Head Alignment.

You see a screen like this:

4. Click the Automatic button, if 
necessary, then click OK.

5. On the next screen, click Start. 
The printer then prints and 
checks an alignment pattern. It 
then prints and checks two more 
patterns.
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6. When alignment is finished, click Finish on the last screen.

Manually Aligning the Print Head

1. Turn on the printer.

2. Load plain, letter-size paper.

3. Do one of the following:

Windows: Right-click the  icon on your taskbar (in the lower right corner of 
your screen). Select Print Head Alignment.

Mac OS X: Open the Applications folder and select EPSON Printer Utility. 
Select SP R1800, click OK, and select Print Head Alignment.

4. Click the Manual button, then click OK. 

You see a screen like this as the printer 
prints an alignment check pattern:

5. On the check page, select the box in each 
pattern that has the least noticeable lines in 
it. You may need to use a magnifying glass 
or loupe.

Select one box for each pattern numbered 
1 through 3. Then enter the box number 
for each pattern in the boxes on the screen. 

If box #5 is not the best-aligned box in each pattern, click Realignment to print 
another test page and repeat this step.

6. When box #5 is the best-aligned in all the patterns, click Finish.
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Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year.

1. Turn off the printer, unplug the power cord, and disconnect the interface cable.

2. Remove all the paper, then use a soft brush to clean the paper feeders.

3. Clean the exterior of the printer with a soft, damp cloth. Keep the paper support 
and printer cover closed as you clean the printer.

4. If you need to clean ink out of the inside of the printer, use a soft cloth to clean 
only the black plastic area shown below:

Warning: Don’t touch the gears or rollers inside the printer.

Caution: Never use a hard or abrasive brush, or benzine, alcohol, or thinner for 
cleaning; they can damage the printer components and case. 

Don’t get water on the printer components and don’t spray or apply lubricants or 
oils inside the printer.

Don’t use any cleaning sheets included with special paper; they may jam inside 
the printer.

Clean here 
only
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Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in 
its original box or a similar one. Follow these steps:

1. Turn on the printer.

2. Turn off the printer and unplug the power cord from the electrical outlet. Then 
disconnect the printer cable from the printer.

3. Open the printer cover and tape the ink cartridge holder to the printer case using 
packing tape. Then close the printer cover.

Caution: Be sure to remove the tape after installing the printer in its new 
location.

4. Remove any paper from the printer, then remove the roll paper holder, if it is 
installed.

5. Close the output tray and the paper support.

6. Repack the printer and its attachments in the original box using the protective 
materials that came with them.

7. Keep the printer level as you transport it. 

8. After transporting the printer, remove all the tape. 

9. Test your printer. If you notice a decline in print quality, clean the print head 
(see page 77); if output is misaligned, align the print head (see page 84). 

Tape the ink 
cartridge holder to 
the printer case
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Solving Problems

See “Diagnosing Printer Problems” on page 91 to help determine what the cause of 
your printer problem may be. Then see these sections for solutions:

■ “Setup and Software Installation Problems” on page 94

■ “Printer Problems” on page 95

■ “Quality Problems” on page 96

■ “Paper Problems” on page 98

■ “CD/DVD Problems” on page 100

■ “Miscellaneous Problems” on page 100

■ “Uninstalling and Reinstalling Printer Software” on page 102

■ “Where To Get Help” on page 103

Tip: It’s a good idea to check Epson’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.



90 Solving Problems

Printer Parts

Paper support and 
extensions

Sheet feeder

Left edge guide Printer cover

Output tray 
extension

Output tray

Ink cartridge holder 
(in home position)

Buttons and lights 
(control panel)

Roll paper edge guide

Roll paper holder IEEE 1394 (FireWire) 
port

USB port

Paper support closed
CD/DVD tray guide

Roll paper guides
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Printer Lights

The tables below summarize the functions of the printer lights. To diagnose problems 
indicated by the printer lights, see below. 

Diagnosing Printer Problems

First, check the printer’s lights (see below) or run a printer check (see page 93).

Light Meaning

) paper out On: printer is out of paper, multiple sheets fed, the wrong size sheet 
fed, or the CD/DVD tray is not in position.

Flashing: paper isn’t loaded for the currently selected paper path, 
paper is jammed, or the output tray is in the wrong position.

H ink (eight) On: an ink cartridge is empty.

Flashing: an ink cartridge is low on ink.

P power On: printer is turned on.

Flashing: printer is receiving a print job, printing, replacing or charging 
ink, cleaning the print head, or moving the output tray position.

Lights Explanation

Green P power light 
flashes

The printer is receiving a print job, printing, replacing an ink 
cartridge, charging ink, or cleaning the print head.

Red H ink light flashes An ink cartridge is low on ink. Make sure you have a 
replacement cartridge, then follow the steps on page 82 to 
install it.

Red H ink light on An ink cartridge is out of ink, not installed, not installed 
correctly, or is not compatible with the printer.

Follow the steps on page 82 to install or reinstall the 
cartridge correctly.
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Red ) paper light on Your paper ran out, multiple sheets fed, or the wrong size 
sheet fed, or the CD/DVD tray is not inserted completely.

Sheet Feeder: If paper is out, load more paper and press 
the ) paper button. If multiple sheets or the wrong size 
sheet fed, press the ) paper button to eject the paper, 
then turn your printer off and then on. For loading 
instructions, see page 14.

Single Sheet Guide: See page 18 for instructions on 
loading single sheets of special papers. 

Roll Paper: See page 22 for instructions on loading or 
reloading roll paper.

CD/DVD: See page 70 for instructions on inserting the 
CD/DVD tray correctly.

Red ) paper light flashes Jammed paper or the CD/DVD tray is blocking print head 
movement, or you’re trying to print on paper or a CD/DVD 
with the wrong media loaded.

If you suspect a paper jam, turn off the printer and pull out 
the jammed paper. Open the cover and remove any 
jammed or torn paper. Then do one of the following:

Sheet Feeder or Single Sheet Guide: Turn on the printer, 
reload paper, and press the ) paper button. 

Roll Paper: Cut off the printed portion, then remove the 
paper (see page 41) and reload it (see page 22).

CD/DVD: Gently pull out the CD/DVD tray and press the 
) paper button. See page 70 for instructions on inserting 
the CD/DVD tray correctly.

If a print job was sent to one paper path, but media is 
loaded for another paper path, load the correct paper or a 
CD/DVD.

Lights Explanation
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
or some other source. 

1. Turn off your printer and computer, then disconnect the printer’s interface cable.

2. Load letter-size paper in the sheet feeder.

3. Hold down the ) paper button, then press and release the P power button. 
Continue to hold down the ) paper button until the P power light flashes.

4. A test page prints the printer’s ROM version number and a nozzle check pattern.

■ If the check page prints, the problem probably lies in your software settings, 
interface cable, or computer, or your software may not be installed correctly.

■ If the check page doesn’t print, you may have a problem with your printer.

Try the suggestions in “Problems and Solutions” beginning on page 94.

5. Turn off the printer, connect the interface cable, and turn on your printer and 
computer.

Green P power light is on

Red ) paper light flashes

Red H ink light flashes

Jammed paper or a foreign object is preventing the print 
head from returning to the home position, or paper is 
loaded in the sheet feeder and the CD/DVD tray guide is 
open. 

Turn off the printer, open the printer cover, and remove 
any jammed or torn paper, or foreign object. Close the 
CD/DVD tray guide if it is open. Then turn the printer back 
on. If the error persists, contact your dealer or Epson; see 
page 103.

Green P power light 
flashes

Red ) paper light flashes

Red H ink light flashes

An unknown printer error has occurred.

Turn off the printer, wait a few seconds, and turn it on 
again. If the lights are still flashing, contact your dealer or 
Epson; see page 103.

Lights Explanation
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Problems and Solutions

Setup and Software Installation Problems

The printer makes noise after ink cartridge installation.

■ When you install ink cartridges, the printer must charge its print head for about 
two and a half minutes. Wait until it’s finished (the green P power light stops 
flashing) before you turn off the printer, or it may use excess ink the next time you 
turn it on. 

■ Make sure the ink cartridges are inserted completely, the ink cover is closed, and 
no packing material remains in the printer. Turn off the printer, wait a moment, 
then turn it back on to clear the error.

You’re having problems installing or using the printer software.

■ Make sure your printer is turned on and its cable is securely connected at both 
ends. Follow the installation steps on the Start Here sheet, and make sure your 
system meets the requirements on page 105.

■ Close other programs, including screen savers and virus protectors, and install 
again.

■ If you see an error message with Windows 2000, you may not have software 
installation privileges. Contact your System Administrator.

■ If you’re using Windows and the USB port, make sure your system was not 
upgraded from Windows 95; the USB driver may not install correctly.

■ If you’re printing over a network, see your on-screen Reference Guide for 
instructions on configuring your printer for use on a network.

■ In Windows, make sure your printer is selected as the default printer in the 
Printers utility. 
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Printer Problems

Only the green P power light is on, but nothing prints.

■ Make sure the interface cable is securely connected at both ends and meets the 
system requirements on page 105.

■ Run a printer check as described on page 93. If the test page prints, make sure 
your software is installed correctly. 

■ If you’re printing on a network, make sure you set up your printer for network 
printing, as described in your on-screen Reference Guide.

The printer sounds as though it is printing, but nothing prints.

■ The print head may need cleaning; see page 77 for instructions.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, 
stable surface.

Your printer makes noise when you turn it on or after it has been sitting for 
awhile.

Your printer is performing routine maintenance.

Printing is too slow.

Make sure your system meets the recommended requirements listed on page 105. 
You may also need to:

■ Clear space on your hard drive or run a defragmentation utility.

■ Close open programs that you’re not using.

■ Increase your system’s memory (RAM).

For the fastest printing:

■ Select Draft (Windows) or set the Quality/Speed slider to Speed (Macintosh).

■ Turn High Speed on and turn Finest Detail off, if available.

■ If your printer is connected to a USB hub, disconnect any unused USB devices. 
Use a Hi-Speed USB 2.0 cable connected to a Hi-Speed USB 2.0 port.
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Quality Problems

You see banding (light lines).

■ Clean the print head; see page 77 for 
instructions. 

■ Select a higher print quality and turn off 
High Speed mode; see page 31 (Windows) 
or page 38 (Macintosh).

■ Select the correct Type or Media Type 
setting for your paper; see page 40.

■ Make sure the printable side of the paper is face-up; it’s usually whiter or shinier.

■ The ink cartridges may need replacing; see page 80.

■ Align the print head as described on page 84.

Your print is blurry or smeared.

■ Make sure your paper isn’t damp, curled, or 
loaded face down (load new paper face up). 

■ Use a support sheet with special paper, or 
try loading your paper one sheet at a time.

■ Make sure your paper meets the 
specifications listed in the on-screen 
Reference Guide. 

■ Use Epson papers for proper saturation and absorption of Epson inks. If you use a 
paper not listed under the supported paper types, you may see smears, roller 
marks, misting, or other problems in your printouts; see page 13.

■ Align the print head as described on page 84.

■ Select the Thick paper checkbox in your printer software. Access the setting from 
the printer settings window as follows:

Windows: Click Maintenance and select Printer and Option Information. 

Mac OS X: Select Extension Setting from the pop-up menu.
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Your printout is faint or has gaps.

■ Clean the print head; see page 77 for 
instructions. 

■ The ink cartridges may be old or low on 
ink; see page 80. 

■ Select the correct Type (Windows) or 
Media Type (Macintosh); see page 40.

■ Make sure your paper isn’t damaged, old, dirty, or loaded face down. For best 
results, use genuine Epson paper.

Caution: Don’t open Epson Status Monitor, pause printing, or respond to any ink 
messages when your printer is printing. This may cause your printer to pause and 
leave an uneven surface on your printout. If your ink is running low, wait until 
printing finishes before checking ink levels or attempting to replace a cartridge. If 
you must replace an ink cartridge in the middle of a print job, the quality of your 
printout may decline. For best results, check your ink levels and replace ink 
cartridges, if necessary, before printing large or high-resolution print jobs.

Your printout is grainy.

■ Use a higher quality paper or select a higher print quality (for Windows, see 
page 31; for Macintosh, see page 38).

■ Align the print head as described on page 84.

■ Increase the image resolution or print it in a smaller size; see your software 
documentation.

■ Make sure you’re not printing a PostScript® file.

You see wrong or missing colors.

■ Make sure Color ink is selected (Macintosh), even when printing black and white 
photographs.

■ Clean the print head; see page 77 for instructions. 

■ The ink cartridges may be old or low on ink; see page 80.
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■ Try turning off PhotoEnhanceTM (Windows). Also check if you’re using a special 
effect that alters image colors, like Sepia.

■ Change the Gamma setting (Macintosh). See page 38.

■ Your printed colors can never exactly match your on-screen colors. However, you 
can use a color management system to get as close as possible. See the Photoshop 
color management instructions on page 52. If your photos have a dark, 
underexposed and/or yellow-brown cast or a light, overexposed and or light-blue 
cast after using color management, see the solutions on page 61. 

Paper Problems

Paper doesn’t eject fully or is wrinkled.

■ If the paper doesn’t eject fully, you may have set the wrong paper size. Press the 
) paper button to eject the paper, then select the correct paper size.

■ If it’s wrinkled when it ejects, the paper may be damp or too thin. Load new 
paper.

Paper sheets don’t feed correctly.

■ If paper doesn’t feed or multiple pages feed, remove it from the sheet feeder. Fan 
the edges of the sheets, reload them against the right side of the feeder, and slide 
the left edge guide against the paper, but not too tightly. Don’t load paper above 
the arrow on the left edge guide. 

■ If you are loading multiple sheets of matte paper that are larger than letter-size, 
use the matte paper support. See page 17. 

Paper sheets jam in the printer.

Press the ) paper button to eject the jammed paper. If that doesn’t work, try the 
following:

1. Turn off the printer.

2. Remove any jammed paper from the printer’s output tray.
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3. Remove any jammed paper from the sheet feeder or open the printer cover and 
remove any paper jammed inside. 

Roll paper doesn’t feed correctly or jams in the printer.

■ Cut the end of the paper straight across. If it’s cut diagonally, the paper won’t feed 
smoothly.

■ If the roll paper end is curled, place the end inside a folded sheet of paper and roll 
it backwards against the curl.

■ Make sure the paper is loaded in the roll paper feeder, not the sheet feeder; see 
page 22.

■ As you load the paper, gently hold it in the roll paper feeder and wait for it to 
load; don’t force the paper in.

■ Select Roll as the Source (Windows) or the correct size and source of Roll Paper 
for the Paper Size (Mac OS X). Other settings will feed too much paper. See 
page 41 for instructions. 

■ If extra paper feeds, press the z roll paper button for three seconds to rewind the 
paper all the way (repeat if necessary). If the ) paper light is on, press the 
) paper button. Reload the paper as described on page 22.
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CD/DVD Problems

You can’t insert the CD/DVD tray easily.

Don’t force the CD/DVD tray into the printer. Turn on your printer and follow all 
the steps beginning on page 70.

The CD/DVD tray ejects when you start a CD/DVD print job.

Follow the steps on page 70 to reinsert the CD/DVD tray. Make sure you press the 
) paper button to load the tray before sending your print job again.

The CD/DVD tray doesn’t eject after printing.

Gently pull out the tray and press the ) paper button to turn off the ) paper light.

Your design is not positioned correctly on the CD or DVD.

You need to adjust the print position in Epson Print CD; see page 74.

Miscellaneous Problems

The image is inverted, as if viewed in a mirror.

Turn off Mirror Image in the printer software or the mirror setting in your program. 
See page 31 (Windows) or page 38 (Macintosh) for instructions. 

The printer prints blank pages.

■ Make sure your printer is selected in the Print window, or in the Macintosh 
Printer Setup Utility or Print Center.

■ Clean the print head; see page 77 for instructions. 
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You see incorrect characters.

■ Make sure the interface cable is securely connected at both ends and meets the 
system requirements on page 105. 

■ Make sure your printer is selected in the Print window, or in the Macintosh 
Printer Setup Utility or Print Center.

■ If you’re using a switch box or USB hub with your printer, connect the printer 
directly to your computer instead.

The margins are incorrect.

■ Make sure the paper settings are correct for your paper size. See page 28 
(Windows) or page 33 (Mac OS X).

■ Choose the correct margins for your paper size. The margins must be within the 
printable area of the page; see “Printer Specifications” in your on-screen Reference 
Guide.

■ Place your paper against the right side of the feeder with the left edge guide snug 
against it. 

■ Make sure the Borderless setting is set correctly for your margins; see page 41 for 
roll paper or page 48 for cut sheets.

Too many copies printed.

Make sure that the Copies option in your printer software or program is not set for 
multiple copies.

Image size/position is incorrect.

Make sure the paper and layout options are set correctly.
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Uninstalling and Reinstalling Printer 
Software

You may need to uninstall and then reinstall your printer driver and utilities if, for 
example, you upgrade your Windows operating system. You don’t need to uninstall 
your other photo software or the Epson Reference Guide. 

Windows 

1. Click Start, and select Programs or All Programs.

2. Point to Epson or EPSON Printers, then select EPSON Printer Software 
Uninstall.

3. In the next window, select EPSON Stylus Photo R1800 and click OK. Then 
follow the on-screen instructions. 

4. Restart your computer, then see the Start Here sheet to reinstall your software.

Mac OS X

1. Open the Applications folder, then the Utilities folder.

2. Select Printer Setup Utility or Print Center, select Stylus Photo R1800, and 
click the Delete button.

3. Restart your Macintosh, then see the Start Here sheet to reinstall your software.



Solving Problems 103

Where To Get Help

If you need help with your printer, Epson Print CD, or the P.I.M. II Plug-in for 
Adobe Photoshop, see the information below. 

For help with other software that came with your printer, see page 104. 

Epson provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed below:

To speak to a technical support representative, dial:

■ U.S.: (562) 276-7296, 6 AM to 8 PM, Pacific Time, Monday through Friday and 
7 AM to 4 PM, Saturday. 

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply. 

Please have the following information ready:

■ Product name (Epson Stylus Photo R1800)

■ Product serial number (located on the back of the printer and on its box)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and operating system version

■ Description of the problem

Service Access

World Wide 
Web

From the Internet, you can reach Epson Support at 
http://support.epson.com. At this site, you can download drivers and 
other files, look at product documentation, access troubleshooting 
information, and receive technical advice through e-mail.

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, seven 
days a week. To use these services, you must have a touch tone 
telephone and call (800) 922-8911. Your Epson SoundAdvice  Express 
Code is 70610. Use this code to quickly select the Epson Stylus Photo 
R1800 in SoundAdvice. 

SM
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You can purchase genuine Epson ink cartridges, paper, and accessories from an Epson 
authorized reseller. For product information and to find the nearest authorized 
reseller, please call 800-GO-EPSON (800-463-7766) or browse our catalog of 
products at www.epson.com, select the product you are interested in, and click 
“Where to Buy.” To purchase online, please visit the Epson Store at 
www.epsonstore.com (U.S. sales only). In Canada, please call 800-463-7766 for a 
reseller referral. 

Technical Support for Other Photo Software

Software Web site or e-mail Telephone

nik Multimedia supportus@nikmultimedia.com (619) 725-3150, 8:30 AM to 
5 PM, Monday to Friday, 
Pacific Time
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Windows System Requirements

To use your printer and its software, we recommend that your system has: 

■ Microsoft Windows compatible PC with a Pentium® III 500 MHz or higher processor (1 GHz or 
higher recommended) 

■ Windows 2000 or XP

■ 256MB or more of RAM (512MB or more recommended)

■ 200MB or more of free hard disk space recommended

■ VGA or better display adapter and monitor

■ CD-ROM or DVD-ROM drive for installing the printer software

■ USB connection: a Windows-compliant USB 1.1 port or Hi-Speed USB 2.0 port (recommended) 
and a shielded USB “AB” cable

IEEE-1394 (FireWire) connection: an OHCI-compliant IEEE-1394 port and an IEEE-1394 
cable

Macintosh System Requirements

To use your printer and its software, we recommend that your system has: 

■ An Apple® iMac™ series or Power Macintosh® G3 (400 MHz or higher), G4 (1 GHz or higher 
recommended), or G5

■ Mac OS X 10.2.4 or later

■ 256MB or more of available RAM (512MB or more recommended)

■ 200MB or more of free hard disk space recommended

■ VGA display or better

■ CD-ROM or DVD-ROM drive for installing the printer software

■ USB connection: a shielded USB “AB” cable (Hi-Speed USB 2.0 recommended)

FireWire connection: an OHCI-compliant FireWire port and a FireWire cable
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Important Safety Instructions

Before using your printer, read these safety instructions to make sure you use it safely and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.
Placez l’imprimante près d’une prise de courant où la fiche peut être débranchée facilement.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total 
ampere rating of all devices plugged into the wall outlet does not exceed the outlet’s ampere rating.

■ Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation, leaving at least 3.9 inches 
between the back of the printer and the wall.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The 
printer will not operate properly if it is tilted or at an angle.

■ When transporting or storing the printer, don’t tilt it, stand it on its side, or turn it upside-down. 
This may allow ink to leak from the ink cartridges.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid 
on the printer.

Caution: Always turn the printer off using the Ppower button. Don’t switch off the power 
strip or unplug the printer until the green Ppower light is off.

■ Do not block or cover the openings in the printer’s case or insert objects through the slots. 

■ Except as specifically explained in this manual, do not attempt to service the printer yourself. 

■ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been 
dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change 
in performance. Adjust only those controls that are covered by the operating instructions.
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Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply 
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.

■ Do not put your hand inside the printer or touch a cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge 
unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use 
up the ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ Store ink cartridges with the bottom of the packaging facing down.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

■ Shake an ink cartridge 4 or 5 times before removing it from its package.

■ Do not shake an ink cartridge after removing it from its package; this can cause leakage.

■ Do not remove or tear the label on an ink cartridge; this can cause leakage.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

■ Do not touch the green IC chip on the front of the cartridge. This may affect normal operation 
and printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the printer. Note that there is a valve in the ink supply port, 
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that 
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

ENERGY STAR Compliance

As an ENERGY STAR Partner, Epson has determined that this product 
meets the ENERGY STAR guidelines for energy efficiency. The EPA 
ENERGY STAR office equipment program is a voluntary partnership with 
the computer and office equipment industry to promote the introduction 
of energy-efficient personal computers, monitors, printers, fax machines, 
and copiers in an effort to reduce air pollution caused by power 
generation.
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which exceed the 
limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a 
shielded equipment interface cable with this device. If this equipment has more than one interface 
connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly 
approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or 
CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson

Type of Product: Ink Jet Printer

Model: B321A

Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser that the 
Epson printer covered by this limited warranty statement, if purchased new and used in the United 
States or Canada, conforms to the manufacturer’s specifications and will be free from defects in 
workmanship and materials for a period of one (1) year from the date of original purchase. Epson also 
warrants that the consumable ink cartridges enclosed with the printer will perform to the 
manufacturer’s specified usage, which usage may expire before the expiration of the limited warranty 
for the Epson printer. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the 
warranty period, please call the Epson Connection  at (562) 276-7296 (U.S.) or (905) 709-2567 
(Canada) for warranty repair instructions and return authorization. An Epson service technician will 
provide telephone diagnostic service to determine whether the printer requires service. If service is 
needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If 
Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, 
freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. 
Possessions). Shipments to other locations will be made freight collect. You are responsible for securely 

SM
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packaging the defective unit and returning it to Epson within five (5) working days of receipt of the 
replacement. Epson requires a debit or a credit card number to secure the cost of the replacement 
printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will 
direct you to send your printer to Epson or its authorized service center, where the printer will be fixed 
and sent back to you. You are responsible for packing the printer and for all costs to and from the 
Epson authorized service center. When warranty service involves the exchange of the printer or a part, 
the item replaced becomes Epson property. The replacement printer or part may be new or refurbished 
to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and 
quality. Epson’s liability for replacement of the covered printer will not exceed the original retail selling 
price of the covered printer. Exchange products and parts assume the remaining warranty period of 
your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned 
products. This warranty covers only normal use in the United States and Canada. Using this product 
for continuous production or similar high duty purposes is not considered normal use; damage, 
maintenance or service from such use will not be covered under this warranty. This warranty is not 
transferable. This warranty does not cover any color change or fading of prints or reimbursement of 
materials or services required for reprinting. This warranty does not cover damage to the Epson 
product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty 
does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to 
the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. 
Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial 
number be removed or should the product fail to be properly maintained or fail to function properly as 
a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters 
such as fire, flood, and lightning, improper electrical current, software problems, interaction with 
non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot 
be identified or reproduced, you will be held responsible for the costs incurred.

SPECIAL NOTE TO COMMERCIAL USERS

This Epson product is offered as a high quality consumer use product. With proper use and care, the 
product will provide you with quality performance well beyond the one year warranty period.  
However, if you use this product for continuous production or similar high duty purposes, none of the 
needed repairs, maintenance or service from such use will be covered by your Epson Limited Warranty.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE 
BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL 
BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE 
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH 
OF WARRANTY OR ANY OTHER LEGAL THEORY.
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In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and 
you may have other rights which vary from jurisdiction to jurisdiction. 

Epson America, Inc. ■  P. O. Box 93012 ■  Long Beach, CA 90809-3012
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Index

A

Adobe Photoshop
managing color with, 52 to 65
P.I.M. plug-in for, 9, 47

Advanced settings
Macintosh, 38 to 39
Windows, 31 to 32

Aligning print head, 84 to 85
Automatic

print head aligning, 84 to 85
print head cleaning, 78

Automatic mode, Macintosh, 36

B

Background printing, 37
Banding, 96
Basic printing

Macintosh, 33 to 37
Windows, 28 to 30

Best Photo setting, 29, 49
Blank pages, 100
Blurry images, 96
Borderless setting, 29, 48 to 51
Bright White Paper, 16, 40
Browser, 11
Buttons, 12, 92 to 93

C

Cable, printer, 105
Cancelling printing

Macintosh, 37
Windows, 30

CDs and DVDs
adjusting print density, 75 to 76
adjusting print position, 74 to 75
inserting in printer, 70 to 72
ordering, 69
printing on, 69 to 76
problems with, 100

Characters, incorrect, 101
Checking printer, 93
Cleaning

print head, 77 to 80
printer, 86
roller, 70

Color management
menu, Macintosh, 36
problems, 61
settings, 31 to 32, 36, 39, 52 to 65
with color profiles, 52 to 65

Color problems, 61, 97
ColorSync, 39
Control panel, 12, 90 to 93
Controlling printing

Macintosh, 37
Custom profiles, 61 to 65
Custom settings

Macintosh, 38 to 39
Windows, 31 to 32

D

Declaration of Conformity, 109
Default settings, Windows, 30
Documentation, 10 to 11
Draft setting, 29, 95
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E

Edge Smoothing setting
color management, 55, 59, 63, 64
Windows, 31

Electronic manual, 10 to 11
Energy Star compliance, 107
Enhanced Matte Paper, 16, 40
Epson

help, 103 to 104
papers, 16, 40, 48
PhotoCenter, 10
Print CD, 73 to 76
SoundAdvice, 103
warranty, 109 to 111

Exif Print
description, 9
printing with, 47

Expansion setting, 49, 51
Extension setting, 36, 96

F

Faint images, 97
FCC Compliance Statement, 108
Features, 7

G

Gamma setting, 98
Gloss Optimizer

cartridge, 7, 81
setting, Macintosh, 38

Gloss setting, Windows, 29
Grainy prints, 97

H

Head Cleaning utility, 79 to 80
Help

Epson, 103 to 104
other software, 104
see also Troubleshooting

High Speed setting, 95 to 96

I

ICM (Image Color Matching) setting, 32, 60, 
65

Incorrect
characters, 101
colors, 61, 97
margins, 101

Ink cartridge
level of ink in, 81
ordering, 81 to 82
problems, solving, 91, 94
replacing, 80 to 84
safety instructions, 82, 107

Ink level, checking
Macintosh, 81
Windows, 81

Installation problems, 94
Inverted image, 100

J

Jams, paper, 92, 98 to 99

L

Layout problems, 101
Layout settings

Macintosh, 36
Windows, 32

Letterhead, 15
Lights, 91 to 93
Luster Photo Paper, 16, 40, 42, 44
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M

Macintosh
basic printing, 33 to 37
custom printing, 38 to 39
system requirements, 105
uninstalling software, 102

Maintaining printer, 77 to 86
Margins, incorrect, 101
Matte Black ink cartridge, 7, 81
Matte paper, 16, 40, 48
Matte sheet support, 17
Media Type setting, Macintosh, 26, 36, 40, 44
Mirror images, 100
Monitoring ink level

Macintosh, 81
Windows, 81

Moving printer, 87

N

Network printing, 94
Noise, printer, 95
Nozzle Check, 78 to 80

O

Orientation setting, 26, 29, 34

P

P.I.M., see PRINT Image Matching
Page Setup, Macintosh, 35
Paper

Epson, 16, 40, 48
feeding problems, 98 to 99
jams, 92, 98 to 99
loading in sheet feeder, 14 to 15
loading special, 16
one only in single sheet guide, 18 to 21
roll, see Roll paper

Paper Size setting, 26, 34
Paper Source setting, 21, 34

Paper Type setting, Windows, 26, 29, 40, 42
Photo Black ink cartridge, 7, 81
Photo RPM setting, 31, 38
Photo setting, 29, 49
Photo software, 9 to 10
PhotoCenter, Epson, 10
PhotoEnhance, 29, 98
PremierArt Paper, 18, 48
Premium Bright White Paper, 16, 40
Premium Glossy Photo Paper, 16, 40, 42, 44, 

48
Premium Luster Photo Paper, 16, 40, 42, 44
Premium Semigloss Photo Paper, 16, 40, 42, 44
Preprinted paper, 15
Print CD software, Epson, 73 to 76
Print Center, MacintoshPrinting

controlling, 37
Print dialog box, Windows, 28, 30
Print head

aligning, 84 to 85
cleaning, 77 to 80

Print Head Alignment utility, 84 to 85
PRINT Image Matching

description, 8 to 9
plug-in for Photoshop, 9, 47

Print position, CD/DVD, 74 to 75
Print Quality

problems, 96 to 97
setting, 38, 63

Print Settings menu, Macintosh, 35
Printer

cable, 105
check, 93
cleaning, 86
control panel, 90 to 93
maintaining, 77 to 86
noise, 95
parts, 90
problems, 91 to 93, 95
transporting, 87

Printing
advanced, 31 to 32, 38 to 39
CDs and DVDs, 69 to 76
Macintosh, basic, 33 to 37
Windows, basic, 28 to 30
with custom settings, 31 to 32, 38 to 39



116 Index

Problems
CD/DVD, 100
diagnosing, 91 to 93
installing software, 94
miscellaneous, 100 to 101
paper feeding, 98 to 99
print quality, 96 to 97
printer, 95
solving, 89 to 104
uninstalling software, 102

Q

Quality Option setting, 29, 49, 59, 64
Quality/Speed setting, 35, 44, 51, 95

R

Reference Guide, 10 to 11
Reinstalling software, 102
Roll paper

button, 25, 45
controlling printing, 45
holder, 23 to 25, 46
loading, 22 to 25, 41
options, 43, 45
printing on, 41 to 45
problems, solving, 92, 99
removing, 46
storing, 46

S

Safety instructions, 106 to 107
Semigloss Photo Paper, 16, 40, 42, 44
Service, 103 to 104
Sheet feeder

loading paper in, 14 to 15
problems, solving, 92, 98 to 99

Single sheet guide, 18 to 21
Size setting, 26, 29, 42
Slow printing, 95
Smeared printout, 26, 36, 96

Software
installation problems, solving, 94
photo, 9 to 10
Print CD, 73 to 76
reinstalling, 102
summary, 9 to 10
uninstalling, 102

SoundAdvice, 103
Source setting, 21, 29, 42, 49
Support, 103 to 104
System requirements, 105

T

Technical support, 103 to 104
Testing printer, 93
Text & Image setting, 29
Text setting, 29
Thick paper setting, 26, 36, 96
Transporting printer, 87
Troubleshooting, 89 to 104
Type setting, Windows, 26, 29, 40, 42

U

UltraSmooth Paper, 40
Uninstalling software, 102
USB, 94, 101, 105
Utilities

Auto Nozzle Check and Cleaning, 78
Head Cleaning, 79 to 80
Nozzle Check, 78 to 80
Print Head Alignment, 84 to 85

V

Velvet Fine Art Paper, 18 to 21
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W

Warranty, 109 to 111
Watermark, 32
Windows

advanced printing, 31 to 32
basic printing, 28 to 30
default settings, 30
system requirements, 105
uninstalling software, 102



Paper name Size Part number

Epson Premium Glossy Photo Paper Letter (8.5 x 11 inches) S041667/S041286

4 x 6 inches, Borderless S041727/S041808

5 x 7 inches, Borderless S041464

8 x 10 inches, Borderless S041465

4 inches x 26 ft roll paper S041302

8.3 inches x 32.8 ft roll paper S041376

B (11 x 17 inches) S041290

A3 (11.7 x 16.5 inches) S041288

Super B (13 x 19 inches) S041289

11 x 14 inches, Borderless S041466

13 inches x 32.8 ft roll paper S041378

Epson Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

4 inches x 26 ft roll paper S041329

Super B (13 x 19 inches) S041327

Epson Premium Luster Photo Paper Letter (8.5 x 11 inches) S041405 

8.3 inches x 32.8 ft roll paper S041408

A3 (11.7 x 16.5 inches) S041406

Super B (13 x 19 inches) S041407

13 inches x 32.8 ft roll paper S04140

Epson Enhanced Matte Paper Letter (8.5 x 11 inches) S041341

A3 (11.7 x 16.5 inches) S041343

Super B (13 x 19 inches) S041339

Epson Matte Paper Heavyweight Letter (8.5 x 11 inches) S041257

8 x 10 inches, Borderless S041467

11 x 14 inches, Borderless S041468

A3 (11.7 x 16.5 inches) S041260

Super B (13 x 19 inches) S041263

Epson Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

Epson Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

Legal (8.5 x 14 inches) S041067

B (11 x 17 inches) S041070

Super B (13 x 19 inches) S041069

Epson Premium Bright White Paper Letter (8.5 x 11 inches) S041586

Epson Photo Quality Self Adhesive Sheets A4 (8.3 x 11.7 inches) S041106

PremierArt™ Matte Scrapbook Photo Paper for Epson Letter (8.5 x 11 inches) SCR1002

12 x 12 inches SCR1003

Epson Watercolor Paper - Radiant White Super B (13 x 19 inches) S041351

Epson Velvet Fine Art Paper Letter (8.5 x 11 inches) S041636

Super B (13 x 19 inches) S041637

Epson UltraSmooth™ Fine Art Paper Super B (13 x 19 inches) SP91209

The availability of paper types varies by location.

Epson Ink Jet Papers
Use Epson® paper and inks to get the same photo quality results that have earned Epson’s printers all of their
awards! Epson papers are specially coated to work with Epson UltraChrome™ inks. Here are details about
just a few of Epson’s papers and your printer’s ink cartridges:

Premium Glossy Photo Paper
Water-resistant paper with a high gloss finish that looks and 
feels just like a traditional photo. Perfect for all photographic 
applications and available in a variety of popular photo sizes,
such as 4 x 6, 5 x 7, 8 x 10, and letter, and in rolls. Framing is
recommended for this paper type.

Premium Luster Photo Paper
This instant drying RC photo paper produces vivid, lifelike images that rival those of
traditional silver halide prints. Its semigloss “E” surface and 10 mil thickness provide a true
photographic look and feel.

Enhanced Matte Paper
Enhanced Matte Paper is the perfect choice for photographers requiring 
a heavyweight photo paper without a gloss finish. Results are highly
saturated images, which maintain excellent highlight and shadow detail.

How To Order Epson Ink and Paper
You can purchase genuine Epson ink cartridges, paper, and accessories from an Epson authorized reseller.
For product information and to find the nearest authorized reseller, please call 800-GO-EPSON (800-463-7766)
or browse our catalog of products at www.epson.com, select the product you are interested in, and click
“Where to Buy.” To purchase online, please visit the Epson StoreSM at www.epsonstore.com (U.S. sales only).
In Canada, please call 800-463-7766 for a reseller referral.

Epson Ink Cartridges

Matte Black: T054820
Photo Black: T054120
Cyan: T054220
Magenta: T054320
Red: T054720
Blue: T054920
Yellow: T054420
Gloss Optimizer (2-pack): T054020

Epson Papers
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Paper name Size Part number

Epson Premium Glossy Photo Paper Letter (8.5 x 11 inches) S041667/S041286

4 x 6 inches, Borderless S041727/S041808

5 x 7 inches, Borderless S041464

8 x 10 inches, Borderless S041465

4 inches x 26 ft roll paper S041302

8.3 inches x 32.8 ft roll paper S041376

B (11 x 17 inches) S041290

A3 (11.7 x 16.5 inches) S041288

Super B (13 x 19 inches) S041289

11 x 14 inches, Borderless S041466

13 inches x 32.8 ft roll paper S041378

Epson Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

4 inches x 26 ft roll paper S041329

Super B (13 x 19 inches) S041327

Epson Premium Luster Photo Paper Letter (8.5 x 11 inches) S041405 

8.3 inches x 32.8 ft roll paper S041408

A3 (11.7 x 16.5 inches) S041406

Super B (13 x 19 inches) S041407

13 inches x 32.8 ft roll paper S04140

Epson Enhanced Matte Paper Letter (8.5 x 11 inches) S041341

A3 (11.7 x 16.5 inches) S041343

Super B (13 x 19 inches) S041339

Epson Matte Paper Heavyweight Letter (8.5 x 11 inches) S041257

8 x 10 inches, Borderless S041467

11 x 14 inches, Borderless S041468

A3 (11.7 x 16.5 inches) S041260

Super B (13 x 19 inches) S041263

Epson Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

Epson Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

Legal (8.5 x 14 inches) S041067

B (11 x 17 inches) S041070

Super B (13 x 19 inches) S041069

Epson Premium Bright White Paper Letter (8.5 x 11 inches) S041586

Epson Photo Quality Self Adhesive Sheets A4 (8.3 x 11.7 inches) S041106

PremierArt™ Matte Scrapbook Photo Paper for Epson Letter (8.5 x 11 inches) SCR1002

12 x 12 inches SCR1003

Epson Watercolor Paper - Radiant White Super B (13 x 19 inches) S041351

Epson Velvet Fine Art Paper Letter (8.5 x 11 inches) S041636

Super B (13 x 19 inches) S041637

Epson UltraSmooth™ Fine Art Paper Super B (13 x 19 inches) SP91209

The availability of paper types varies by location.

Epson Ink Jet Papers
Use Epson® paper and inks to get the same photo quality results that have earned Epson’s printers all of their
awards! Epson papers are specially coated to work with Epson UltraChrome™ inks. Here are details about
just a few of Epson’s papers and your printer’s ink cartridges:

Premium Glossy Photo Paper
Water-resistant paper with a high gloss finish that looks and 
feels just like a traditional photo. Perfect for all photographic 
applications and available in a variety of popular photo sizes,
such as 4 x 6, 5 x 7, 8 x 10, and letter, and in rolls. Framing is
recommended for this paper type.

Premium Luster Photo Paper
This instant drying RC photo paper produces vivid, lifelike images that rival those of
traditional silver halide prints. Its semigloss “E” surface and 10 mil thickness provide a true
photographic look and feel.

Enhanced Matte Paper
Enhanced Matte Paper is the perfect choice for photographers requiring 
a heavyweight photo paper without a gloss finish. Results are highly
saturated images, which maintain excellent highlight and shadow detail.

How To Order Epson Ink and Paper
You can purchase genuine Epson ink cartridges, paper, and accessories from an Epson authorized reseller.
For product information and to find the nearest authorized reseller, please call 800-GO-EPSON (800-463-7766)
or browse our catalog of products at www.epson.com, select the product you are interested in, and click
“Where to Buy.” To purchase online, please visit the Epson StoreSM at www.epsonstore.com (U.S. sales only).
In Canada, please call 800-463-7766 for a reseller referral.

Epson Ink Cartridges

Matte Black: T054820
Photo Black: T054120
Cyan: T054220
Magenta: T054320
Red: T054720
Blue: T054920
Yellow: T054420
Gloss Optimizer (2-pack): T054020

Epson Papers

CPD19345_Fue_UG.qxd  2/8/05  4:40 PM  Page 2
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